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This document is provided to customers who have purchased AB SCIEX equipment to use in the 
operation of such AB SCIEX equipment. This document is copyright protected and any 
reproduction of this document or any part of this document is strictly prohibited, except as AB 
SCIEX may authorize in writing. 

Software that may be described in this document is furnished under a license agreement. It is 
against the law to copy, modify, or distribute the software on any medium, except as specifically 
allowed in the license agreement. Furthermore, the license agreement may prohibit the software 
from being disassembled, reverse engineered, or decompiled for any purpose. Warranties are as 
stated therein. 

Portions of this document may make reference to other manufacturers and/or their products, 
which may contain parts whose names are registered as trademarks and/or function as 
trademarks of their respective owners. Any such use is intended only to designate those 
manufacturers' products as supplied by AB SCIEX for incorporation into its equipment and does 
not imply any right and/or license to use or permit others to use such manufacturers' and/or their 
product names as trademarks. 

AB SCIEX warranties are limited to those express warranties provided at the time of sale or 
license of its products and are AB SCIEX’s sole and exclusive representations, warranties, and 
obligations. AB SCIEX makes no other warranty of any kind whatsoever, expressed or implied, 
including without limitation, warranties of merchantability or fitness for a particular purpose, 
whether arising from a statute or otherwise in law or from a course of dealing or usage of trade, all 
of which are expressly disclaimed, and assumes no responsibility or contingent liability, including 
indirect or consequential damages, for any use by the purchaser or for any adverse 
circumstances arising therefrom. 

For research use only. Not for use in diagnostic procedures. 
The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their respective 
owners. Eksigent is a division of AB Sciex, LLC. 

AB SCIEX™ is being used under license. 

© 2013 AB Sciex Pte. Ltd. 

Printed in USA. 
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Chapter 1.  
Safety and Site Requirements 
Chapter 1 describes safety conventions, safety procedures and site requirements necessary for 
proper operation of the Eksigent NanoLC® Ultra systems. Topics covered in this chapter include: 

• NanoLC Ultra Systems Safety Practices (Section 1.1) 
• NanoLC AS-2 Autosampler Safety Practices (Section 1.2) 
• Site Requirements (Section 1.3) 

1.1 NanoLC Ultra System Safety Practices 
The following safety practices apply to the NanoLC Ultra system: 

 

WARNING! Potential Operator Injury: Use of this equipment in a manner not 
approved by the manufacturer may inhibit its safety protection. 

 
 

 

WARNING! Electrical Shock Hazard: Only use fuses of the type and current 
rating specified. Do not use repaired fuses or by-pass the fuse holder.

 
 

 

WARNING! Electrical Shock Hazard: The supplied power cord must be used 
with a power outlet containing a protective ground contact. 

 
 

 

WARNING! Biohazard: When replacing tubing or fittings on the NanoLC Ultra 
system, exposure to solvents may occur. It is therefore recommended that 
appropriate safety procedures be followed and personal protective equipment 
be used, according to the applicable Material Safety Data Sheets supplied by 
the solvent vendor. 

 
 



Safety and Site Requirements 
 

 
NanoLC Ultra® Systems  Operator Guide 
8 of 145  April 2013 

 

WARNING! Environmental Hazard Do not allow flammable and/or toxic 
solvents to accumulate. Follow a regulated, approved waste disposal 
program. Never dispose of flammable and/or toxic solvents into a municipal 
sewage system. 

 

1.2 NanoLC AS-2 Autosampler Safety Practices 
The following safety practices apply to the optional NanoLC Ultra AS-2 autosampler: 

 
Caution:  Changes or modifications to this unit not expressly approved by the 
manufacturer could void the instrument warranty and render the system inoperable. 

 
Caution:  When you use the NanoLC AS-2 autosampler, follow generally accepted 
procedures for quality control and methods development. 

 
Caution:  When you use the NanoLC AS-2 autosampler for chromatographic analyses 
and observe a change in the retention of a particular compound, the resolution between 
two compounds or peak shapes, immediately determine the reason for the changes. Do 
not rely on the analytical results until the cause of the change is determined. 

 

 

WARNING! Potential Operator Injury: Use of this equipment in a manner not 
approved by the manufacturer may inhibit its safety protection. 

 
 

 

WARNING! Electrical Shock Hazard: Only use fuses of the type and current 
rating specified. Do not use repaired fuses or by-pass the fuse holder.

 
 

 

WARNING! Electrical Shock Hazard: The supplied power cord must be used 
with a power outlet containing a protective ground contact. 
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WARNING! Electrical Shock Hazard: Do not change the external or internal 
grounding connections. Tampering with or disabling these connections could 
create a safety hazard and/or damage the NanoLC AS-2 autosampler. The 
instrument, as shipped, is properly grounded in accordance with normal 
safety regulations. 

 
 

 

WARNING! Electrical Shock Hazard: The combination of a NanoLC AS-2 
autosampler with a LC/MS system may require additional safety measures as 
described by the LC/MS system vendor. See the mass spectrometer vendor’s 
operating/installation manual for detailed instructions for the safe grounding 
on the LC/MS system.  

 
 

 

WARNING! Electrical Shock Hazard: Use a grounding cable connected 
between the injection valve’s sample loop and an appropriate grounding point 
at the LC/MS source. This supplementary grounding will reinforce the safety 
configuration specified by the LC/MS system vendor. 

 
 

 

WARNING! Potential Instrument Damage: Do not turn the autosampler on if 
you suspect that it has incurred any kind of electrical damage. Instead, 
disconnect the power cord and contact AB SCIEX Technical Support for a 
product evaluation. Do not attempt to use the instrument until it has been 
inspected and approved for use. 

 
 

 

WARNING! Potential Instrument Damage: Electrical damage may have 
occurred if the system shows visible signs of damage, exposure to liquids or 
of having been transported under severe stress. 

 
 

 

WARNING! Potential Instrument Damage: Damage can also result if the 
autosampler is stored for prolonged periods under extreme conditions (for 
example, subjected to heat, water, etc.). 
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WARNING! Electrical Shock Hazard: Disconnect the power cord from its 
power supply before attempting any type of maintenance. Continue to 
exercise caution as capacitors inside the instrument may still be charged even 
after the instrument has been turned off. 

 
 

 

WARNING! Potential Instrument Damage: To avoid damaging electrical parts, 
do not disconnect an electrical assembly while power is applied to the NanoLC 
AS-2 autosampler. Once the power is turned off, wait approximately 30 
seconds before disconnecting an assembly. 

 
 

 

WARNING! Potential Instrument Damage: This instrument contains a number 
of sensitive electronic components that may be damaged if exposed to 
excessive line voltage fluctuations and/or power surges. 

 
 

 

WARNING! Puncture Hazard: To avoid injury during NanoLC AS-2 
autosampler operation, keep hands and loose objects away from the 
autosampler arm and syringe assembly. 

 
 

 

WARNING! Puncture Hazard: Do not operate the NanoLC AS-2 autosampler 
without the safety shield properly installed. 

 
 

 

WARNING! Biohazard: At all times, observe safe laboratory practices when 
handling solvents, changing tubing or operating the NanoLC AS-2 
autosampler in order to avoid injury. Know the physical and chemical 
properties of the solvents you use. Refer to the solvent manufacturer’s 
Material Safety Data Sheets (MSDS) for any solvent being used for 
information. 
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WARNING! Potential Operator Injury: Use caution when working with any 
polymeric tubing under pressure: 
– Always wear proper eye protection when near pressurized polymer tubing. 
– Do not use polymer tubing that has been severely stressed or kinked. 
– Do not use polymer tubing, in particular PEEK or DuPont Tefzel tubing, with 
tetrahydrofuran (THF), dimethylsulfoxide (DMSO), chlorinated organic 
solvents, concentrated mineral acids, such as nitric, phosphoric or sulfuric 
acids, or any related compounds. 

 
 
Caution:  An on-board lithium battery maintains the autosampler firmware when the 
instrument is turned off. Because it is hard-wired in place, it should only be replaced an 
AB SCIEX FSE. 

 

1.3 Site Requirements 
This section describes the requirements for power, air, space and environment for operation of 
your instrument. 

1.3.1  NanoLC Ultra System Power Requirements 
The NanoLC Ultra instrument is powered by a 24 and 5 VDC external power supply. Only the 
Eksigent power supply provided with the instrument should be used. 

The Eksigent power supply permits operation from any line voltage between 100–240 VAC, 47–
63 Hz and requires 3.0 A at 115 VAC or 1.5 A at 230 VAC.  

Fuses: 

• For 115 VAC; two 3.0 A (5 x 20 mm) fuses 
• For 230 VAC; two 1.5 A (5 x 20 mm) fuses 
• All fuses are UL-listed and CSA-certified 

1.3.2 NanoLC AS-2 Autosampler Power Requirements 
The NanoLC AS-2 autosampler requires a line voltage between 95–240 VAC and 2 A. 

1.3.3 Gas Supply Requirements 
Operation of the instrument requires connection to a source of 100 psi (6.9 bar) regulated clean, 
dry air or nitrogen. The instrument site should be within 6 m (20 ft) of the air/nitrogen regulator. 
When using compressed air, AB SCIEX strongly recommends an air supply having a dew point 
of less than 4.5°C (40°F). When using dry nitrogen or compressed air, AB SCIEX strongly 
recommends the use of air filtration to 5 µm (for compressed gas supplied at less than 150 psi, a 
Wilkerson F18 filter) and regulation to a working pressure of 100 psi (for example, for com-
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pressed gas supplied at less than 150 psi, a Wilkerson R18 regulator or a Wilkerson B18 
combination regulator/filter). If hydrocarbons are suspected in the air supply (such as air supplied 
from an oil-based compressor), AB SCIEX strongly recommends the regulator be followed with a 
coalescing filter suitable for particle removal to 0.01 µm (for example, a Wilkerson M18 
coalescing filter). 

 

Note: Always follow manufacturer’s specifications in selecting and operating gas 
filters and regulators. 

 
 

 

Note: Always follow manufacturer’s specifications for connecting, mounting and 
orienting gas filters and regulators. 

 
 

 

Note: Always perform proper maintenance of traps, filters and coalescing filters 
per manufacturer’s specifications. Liquids collected in filters and coalescing filters 
must be drained before the liquid level exceeds the manufacturer’s specifications. 

 
 

1.3.4 Bench Space Requirement 
The NanoLC Ultra system requires clear bench space of at least the following dimensions. 

• 14 inches (36 cm) wide × 24 inches (61 cm) deep × 18 inches (46 cm) high (allow 
excess space for cables). 

With the NanoLC AS-2 autosampler, the height requirement for both systems is 32 inches 
(81 cm). 

This bench space requirement does not include space for the computer, keyboard, mouse and 
monitor. 

1.3.5 Environment Requirements 
The instrument is designed to operate in an environment with ambient temperatures between 
15°C and 30°C (59°F to 86°F) and non-condensing humidity. 
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Chapter 2.  
System Installation 
Chapter 2 describes the recommended procedure for unpacking and installing the Eksigent 
NanoLC® Ultra system. Topics covered in this chapter include: 

• NanoLC Ultra Systems Overview (Section 2.1) 
• Unpack the NanoLC Ultra System (Section 2.2) 
• Place the System (Section 2.3) 
• Install the Software and Instrument Settings (Section 2.4) 
• Connect to the Gas Supply (Section 2.5) 
• Connect the NanoLC Ultra System to Power (Section 2.6) 
• Connect the PC (Section 2.7) 
• Configure the NanoLC Ultra System (Section 2.8) 

2.1 NanoLC Ultra Systems Overview 

 

Note: This guide is written for standard NanoLC Ultra systems. Some sections in the 
operator guide describe features which may not be included in a specific system. 

 
The NanoLC Ultra systems are designed for HPLC applications that employ direct pumping at 
flow rates of several hundred nanoliters per minute. The fully integrated system includes binary 
gradient pumps, an additional pump or second binary gradient pump system, a column-switching 
valve, an operator guide, and temperature-controlled flow modules and column compartment. 
The system is compatible with the AS-1 and AS-2 autosamplers. 

• The high flow rate channel is optimized to run from 1 µL/min to 10 µL/min. 
• The low flow rate channel is optimized to run from 50 µL/min to 500 nL/min. 
• The sample loading channel is optimized to run at 1 µL/min to30 µL/min. 

This chapter introduces the hardware and software features of NanoLC Ultra systems. 
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2.2 Unpack the NanoLC Ultra System 
1. Inspect the shipping cartons for damage or evidence of mishandling. If external 

damage is evident, notify the carrier before opening the cartons. 

2. Cut the tape and open the flaps on the top of the NanoLC Ultra system shipping box.  

3. Remove the foam from the box. 

4. Grasp the sides of the cardboard cradle and carefully lift the NanoLC Ultra system out 
of the box.  

A second person may be needed to help lifting the system. 

5. Place the instrument on the floor. 

6. Grasp the sides of the instrument and place the instrument on a lab bench. 

7. Cut and open the accessory kit shipping box. 

8. Unpack the computer and monitor and verify that no parts are missing or damaged. 

2.3 Placement of the System 
Place the NanoLC Ultra system on a lab bench in a location with convenient access to power 
and a source of 100 psi (6.9 bar) regulated clean, dry air or nitrogen. The front of the instrument 
should be accessible at all times. The top of the instrument should be clear for placement of the 
mobile phase bottles; and the sides and back of the instrument should be clear to accommodate 
computer cables and fluidic tubing. 

2.4 Install the Software and Instrument Settings 
 

Required Materials 

• CD with Eksigent control software  
• CD with system settings 

1. Insert the CD with the control software into the CD drive and install the Eksigent 
control software (see software manual for additional information on installation). 

2. After installing the software, but before starting it, insert the CD with the system 
settings (shipped with the new instrument). 

3. Locate the file named “EkSettings.reg” in the Settings subfolder. 

4. Double-click EkSettings.reg file to install the instrument settings into the registry of 
the computer.  
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A dialog appears, asking you if you want to write to the registry (Figure 2-1). 

 
Figure 2-1 First Registry Dialog 

5. Click Yes.  

A second dialog appears, indicating that you have successfully written to the registry 
(Figure 2-2). 

 
Figure 2-2 Second Registry Dialog 

6. Click OK. 

The factory settings for your instrument should now be loaded into the registry. You 
should still configure the system (Section 2.8) in case the COM port or other settings 
need to be adjusted from the factory defaults. 

  



System Installation 
 

 
NanoLC Ultra® Systems  Operator Guide 
16 of 145  April 2013 

2.5 Connect to the Gas Supply 
Operation of the instrument requires connection to a source of 100 psi (6.9 bar) regulated clean, 
dry air or nitrogen as described in Section 1.3.3 (Gas Supply Requirements). 

 
Figure 2-3 Rear panel—gas connection  
 

Required Materials 

• Clean, dry source of air or nitrogen at 100 psi (6.9 bar) 
• In-line moisture trap with ¼ inch end-fittings (recommended if an air compressor is 

used) 
• ¼ inch gas supply line (included) 
• Quick-connect adaptor to ¼ inch supply line (included) 

1. Connect the supplied gas line to a source of 100 psi (6.9 bar) regulated clean, dry air 
or nitrogen using the supplied quick-connect adaptor.  

2. Connect the other end of the gas line to the connection on the back of the NanoLC 
Ultra system (see Figure 2-3). 

3. Turn on the gas source to the NanoLC Ultra system. 

4. Test for leaks. Turn off gas supply and repair any leaks that are found. 

Air 
connection

Air 
connection
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2.6 Connect the NanoLC Ultra System to Power 
 
Required Materials 

• Eksigent combination 24 and 5 VDC power supply (included) 

 

1. Insert the Eksigent power supply’s plug into the connector located on the back of the 
instrument and the power supply (Figure 2-4 and Figure 2-5).  

 
Figure 2-4 Eksigent Power Supply—Power Connection 

 
Figure 2-5 Rear Panel—Power Connection 

2. Plug the line voltage cord into an appropriately grounded line voltage outlet. 

To Ultra system

To grounded 
line voltage 
outlet

To Ultra system

To grounded 
line voltage 
outlet

24 / 5 VDC24 / 5 VDC
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3. Turn the Eksigent power supply on using the power switch on the back of the power 
supply. 

4. Turn the NanoLC Ultra system on using the power switch on the back of the unit. 

2.7 Connect the PC 

 

Note: The Eksigent control software must be installed before connecting the 
instrument to the PC. 

 
 
Required Materials 

• Computer, keyboard and mouse 
• System USB cable (included) 

 

1. Connect the Type A (Figure 2-6) connector of the USB cable to an available USB port 
on the computer.  

 
Figure 2-6 USB Connectors—Type A (Left) and Type B (Right) 

2. Connect the Type B (Figure 2-6) connector of the USB cable to the USB port labeled 
USB on the rear panel of the NanoLC Ultra system (Figure 2-7).  

http://en.wikipedia.org/wiki/Image:USB_TypeAB_Diagram.svg
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Make sure the connectors are securely connected. 

 
Figure 2-7 Rear Panel—USB Connector 

  

USB portUSB port
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2.8 Configure the NanoLC Ultra System 
1. Power up the NanoLC Ultra system.  

2. To determine which COM port the system is connected to, go to Control Panel > 
System > Hardware (Figure 2-8). 

 
Figure 2-8 System Properties Dialog—Hardware Tab 
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3. Click Device Manager to display the Device Manager dialog (Figure 2-9). 

 
Figure 2-9 Device Manager Dialog 

4. Expand the Port (COMS and LPT) in the Device Manager dialog. 

The three USB serial ports shown are the COM ports associated with the NanoLC 
Ultra system. The number assigned to the serial port will be different from PC to PC. 
The first USB serial port is assigned to the NanoLC Ultra instrument. The second and 
third serial ports are assigned to RS 232 (A) and RS 232 (B), respectively. It is 
recommended that NanoLC AS-2 autosampler be connected to RS 232 (A). 

5. Launch the Eksigent control software from your computer’s Programs menu or from 
the icon on the desktop.  

A COM Error dialog (Figure 2-10) will appear. 

 
Figure 2-10 Serial Port Communications Error 

6. Click Cancel. 
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A second window will appear (Figure 2-11).  

 
Figure 2-11 Running the Software in Demo Mode 

7. Click OK to enter the software in DEMO MODE and display the Acquisition window 
(Figure 2-12) . 

 
Figure 2-12 Acquisition Window 
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8. Select System > Instrument Configuration from the Eksigent control software’s 
Acquisition window to access the Instrument Configuration dialog (Figure 2-13).  

 
Figure 2-13 Instrument Configuration Dialog—System Tab 
The Instrument Configuration dialog is used to indicate which components are 
installed. It also sets the communications protocol and configures the system to work 
with other connected devices. Several instrument performance parameters are also 
set in this window. 

9. Make sure that one of the following systems is selected in the Eksigent Device field. 

• nanoLC Ultra-1D  
• nanoLC Ultra-1D+ 
• nanoLC Ultra-2D 
• nanoLC Ultra-2D+ 

10. Select the COM port that is connected to the system. (Refer to step 4.) 

11. In the Injection Valve field, select Eksigent Internal. 
12. The system shut-down check box is an option to turn off the system after it is idle for 

the specified time. 
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13. If an auxiliary A/D input (such as a UV detector) is connected to the system, select the 
voltage range the external device will provide under Input A/D Range. (Figure 2-14). 

 
Figure 2-14 Instrument Configuration Dialog—Device I/O Tab 

14. Click the Advanced tab (Figure 2-15) to set the Flow Stabilization Limits which 
specify the degree of flow rate stability that is required before a gradient will begin.  
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The recommended setting is 100 nL/min. 

 
Figure 2-15 Instrument Configuration Dialog—Advanced Tab 

15. The Stop device if Pc exceeds field (Figure 2-15) allows for the specification of a 
maximum system pressure.  

If the column pressure exceeds this limit, the run will be automatically stopped and no 
further injections will take place. For most applications a value of 10 000 psi is 
recommended. 

16. Click OK to go back to the Acquisition window (Figure 2-12). 
The Re-start Required dialog will appear. (Figure 2-16) 

 
Figure 2-16 Re-start Required Dialog 

17. Click OK to automatically end the software. 

18. Launch the Eksigent control software. 
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Chapter 3.  
System Initialization 
Chapter 3 describes procedures used to prepare a system for initial operation or for operation 
following an extended period of non-use. Topics covered in this chapter include: 

• Hardware Components and Functions (Section 3.1) 
• Channel Assignment in the Eksigent Control Software (Section 3.2) 
• Load the Mobile Phases (Section 3.3) 
• Verify the Flow Rate (Section 3.4) 
• Prepare the NanoLC AS-2 Autosampler (Section 3.5) 
• Flush the Autosampler Syringe and Liquid Path (Section 3.6) 
• Connect the NanoLC® Ultra System to the Autosampler (Section 3.7) 

3.1 Hardware Components and Functions 
This section provides a general description of the key components of the NanoLC Ultra systems 
and their various functions. 

Mobile phase outlets are located on the left side of the temperature-controlled column 
compartment in the NanoLC Ultra system (Figure 3-1). Each gradient pump has one mobile 
phase outlet which can be connected to the autosampler and a 10-port column-switching valve. 
The sample loading pump mobile phase outlet is located at the bottom-left corner of the lower 
front bezel (Figure 3-2). 
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Figure 3-1 Mobile phase outlets 

 
Figure 3-2 Sample loading outlet 

Mobile phase 
outlets
Mobile phase 
outlets

Sample 
loading outlet
Sample 
loading outlet
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The 10-port column-switching valve is used to switch between a trap column that is connected to 
the valve for rapid sample loading. The valve(s) is/are located in the temperature-controlled 
column compartment. Refer to Appendix C for different valve configurations. 

3.2 Channel Assignment in the Eksigent Control Software 
Table 3-1 shows the channel assignment in the Eksigent control software for the NanoLC Ultra 
series system for standard configurations. 

Table 3-1 Channel Assignment in the Eksigent Control Software for the NanoLC Ultra 
Series System  

System Gradient 1 Gradient 2 Loading Pump 

Ultra 1D Nano flow  
(50 nL/min to 500 nL/min)  

N/A N/A 

Ultra 1D+ Nano flow  
(50 nL/min to 500 nL/min)  

N/A Micro flow  
(1 µL/min to 30 µL/min) 

Ultra 2D Micro flow  
(1 µL/min to10 µL/min) 

Nano flow  
(50 nL/min to 500 nL/min)  

N/A 

Ultra 2D+ Nano flow  
(50 nL/min to 500 nL/min)  

Nano flow  
(50 nL/min to 500 nL/min)  

Micro flow  
(1 µL/min to 30 µL/min) 
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3.3 Load the Mobile Phases 
The procedure for loading mobile phases will be described for a single binary gradient system for 
reverse phase chromatography.  

 

Note: Purging and flushing the pumps are critical operations to get maximum 
performance from a new instrument. Purging rapidly replaces the solvent in the pumps 
while flushing replaces the solvent in the capillaries connecting the pumps to the 
sample injector. 

 
 
Required Materials 

• 250 mL mobile phase bottles (PN 300-00057) 
• Clean, degassed HPLC-grade mobile phase A (for example, water with 0.1% formic 

acid) 
• Clean, degassed HPLC-grade mobile phase B (for example, acetonitrile with 0.1% 

formic acid) 
• Mobile phase tubing (PN 801-00062) 
• Bottle filters (PN 200-00235) 
• Super flangeless nuts (PN 200-00310) 
• Super flangeless ferrules (PN 200-00269) 

 

1. Clean all 250 mL mobile phase bottles with appropriate solvents. 

2. Fill bottle A with mobile phase A and bottle B with mobile phase B.  

3. Connect mobile phase tubing to the mobile phase connections in the back of the 
system. (Figure 3-3). 
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Figure 3-3 Back Panel—Bottles and Mobile Phase Connections for the 

NanoLC Ultra-2D System 
4. Insert tubing through the pre-drilled bottles caps. 

5. Install the bottle filters at the end of the tubing. 

6. Insert the bottle filters in the bottle and place the caps onto the bottles. 

7. Place the mobile phase bottles in the rack on top of the system. 

Bottle A Bottle B

Mobile phase 
connections

Bottle A Bottle B

Mobile phase 
connections
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8. Insert the waste tubing from the pumps to the provided waste bottle. Place the waste 
bottle on top of the bench. 

9. Select System > Mobile Phases from the main window of the Eksigent control 
software to display the Mobile Phases dialog (Figure 3-4). 

 
Figure 3-4 Mobile Phases Dialog  

10. Set the composition for mobile phase A: Enter the correct solvent composition for 
Mobile Phase A.  

11. Set the composition for mobile phase B: Enter the correct solvent composition for 
Mobile Phase B.  

12. Click More to display the Purge and Flush settings groups (Figure 3-5). 

 
Figure 3-5 Mobile Phases Dialog—Advanced Options 

13. Purge the bubbles from each pump using the following steps: 
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14. Under Purge Settings, select the pump to purge. Set the number of purge cycles to 
20. Check the box Apply to all channels to purge all pumps simultaneously.  

15. Click Purge Now. The pumps will begin to execute purge cycles.  

While the pumps are purging, make sure the mobile phases are pulled through the 
mobile phase tubing to the pumps. 

16. Locate the waste tubing of the pumps being purged. After about 8 purges, the mobile 
phase should be purged through the waste tubing.  

17. Enter 200 for the µL Flush volume and select a flow rate appropriate for the 
maximum flow of the channel.  

• For high flow channels, select 10 for the µL/min Total Flow rate.  
• For low flow channels, select 2000 for the nL/min Total Flow rate.  

18. Ensure that the outlets of the pump are disconnected before proceeding. Flushing the 
system with a column connected could over-pressure the system and create leaks. 

19. Click Flush Now. 

20. After the flush sequence ends, click OK to close the Mobile Phases window. 
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3.4 Verify the Flow Rate 
Before operating the system it is suggested that you verify that the flow rate is properly 
calibrated. This is done by measuring the time it takes to move a liquid front through a graduated 
capillary of known volume. 

 
Required Materials 

• Flow calibration assembly (PN 801-00063) for high flow rate channel (includes 20 µL 
pipettes) 

• Flow calibration assembly (PN 801-00064) for low flow rate channel (includes 5 µL 
graduated pipettes) 

 

1. Re-initialize the pressure transducers (refer to Section 4.5). 

2. Attach the appropriate flow calibration assembly to the outlet of gradient 1 or 2. 

3. Select System > Direct Control from the Eksigent control software Acquisition 
window to display the Direct Control dialog (Figure 3-6).  

 
Figure 3-6 Direct Control Dialog—Flow Rate Check  

4. Set channel A to 100% and an appropriate flow rate for that channel. 

• 5 µL/min for high flow channel 
• 500 nL/min for low flow channel 

5. Click Start and begin timing.  
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• With the high flow calibration assembly, the time it takes for the meniscus or an air 
bubble to transit from the black stripe to the end of the capillary should be 4 
minutes.  

• With the low flow calibration assembly, the time it takes for the meniscus or an air 
bubble to transit across two segments of the capillary (2 µL) should be 4 minutes.  

6. Click Stop when the fluid front reaches the end of the pipette. 

If the flow rate falls outside of the acceptable range (> ±5%), re-calibrate the flow 
meters using the procedure found in Section 4.8. 

7. Disconnect the calibration assembly and blow out the liquid inside the pipette using a 
pipette bulb or can of compressed air. 

8. Set channel B to 100% and repeat steps 5 and 6 to verify the flow rate for pump B.  

9. Disconnect the calibration assembly.  
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3.5 Prepare the NanoLC AS-2 Autosampler 
The NanoLC AS-2 autosampler is the standard autosampler installed with the NanoLC Ultra 
system. Refer to the autosampler operator guide for a detailed description of its operation. 

 
Required Materials 

• Power cord (included) 
• RS-232 serial cable (included) 
• Clean HPLC-grade water 
• Clean HPLC-grade isopropanol 

 
Figure 3-7 Eksigent NanoLC Ultra with NanoLC AS-2 autosampler  

1. Place the NanoLC Ultra system on top of the NanoLC AS-2 autosampler (Figure 3-7). 
A second person might be needed to lift the system. 

2. Connect the power cable to the back of the autosampler and a grounded line voltage 
outlet. 

3. Connect one end of the RS-232 serial cable to the serial port labeled 
“communication” on the back of the autosampler.  
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4. Connect the other end to one of the RS 232 (A) COM port at the back of the NanoLC 
Ultra system (Figure 3-8). 

 
Figure 3-8 Back Panel–RS 232 (A) COM Port Connector Location 

5. Fill the wash bottle with a 20:80 mixture of isopropanol/water that has been 
degassed.  

6. Place the wash bottles on the wash station bracket and insert the Teflon tubing. 

7. Power up the autosampler on using the power switch on the back of the autosampler. 

8. Start the Eksigent control software. 

9. Click Run Manager in the Acquisition window to display the Run Manager window 
(Figure 3-9). 

 
Figure 3-9 Run Manager Window 

RS 232 (A)RS 232 (A)
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10. Select Devices > Autosampler Type > Eksigent NanoLC AS-2.  

The following message appears (Figure 3-10): 

 
Figure 3-10 Warning: no autosampler detected Dialog 

11. Click Cancel. 
12. Select Devices > Autosampler Device Settings to display the Autosampler 

Configuration dialog (Figure 3-11). 
13. Set the COM port for the autosampler (refer to Section 2.8). 

 
Figure 3-11 Autosampler Configuration Dialog  
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An initializing autosampler configuration dialog will appear (Figure 3-12). 

 
Figure 3-12 Initializing Autosampler Dialog 
If the autosampler is successfully connected to the NanoLC Ultra system, the Run 
Manager window will show the NanoLC AS-2 state as idle. 

14. In the Run Manager window, select Devices > Autosampler Device settings. 

15. Click the Direct Control tab (Figure 3-13) and click Exchange in the Plate Position 
area.  

This will move the vial holders to a more accessible location to place the reagent and 
sample vials. 

 
Figure 3-13 Autosampler Configuration Dialog—Direct Control Tab 

16. Place the reagent and sample files in the autosampler, then click Home. 

3.6 Flush the Autosampler Syringe and Liquid Path 
1. In the Run Manager window, select Devices > Autosampler Device Settings. 



System Initialization 
 

 
NanoLC Ultra® Systems  Operator Guide 
40 of 145  April 2013 

2. In the Direct Control tab of the Autosampler Configuration dialog, click Start in the 
Initial Wash area. 

3. Repeat step 2 until the syringe is full of liquid with no bubbles. 

3.7 Connect the NanoLC Ultra System to the Autosampler  
 
Required Materials 

• Nut and ferrule for 1/32 inch fitting (PN 910-00085 and 910-00087) 
• Two pieces of 75 cm, 1/32 inch µm outside diameter (OD)/ 50 µm ID PEEKsil tubing 

(PN 205-00049)  
or 
Two meters of 360 µm OD/ 50 µm inside diameter (ID) fused silica (PN 910-00002) 

• Capillary cutter (PN 200-00096) 
• Natural PEEK sleeves (PN 910-00088) 
• Waste and seal rinse bottle and bracket (PN 300-00000 and 800-000321) 

 

 

Note This section assumes connection of the NanoLC AS-2 autosampler using the 
high flow channel of the NanoLC Ultra instrument. If you are connecting with the low 
flow channel through the NanoLC AS-2 autosampler (for example, for direct loading 
experiments), use 20 µm ID PEEKsil or capillary for the connections to reduce delay 
volume. Two pieces of 75 cm, 1/32 inch OD / 20 µm ID PEEKsil (PN 205-00048) are 
included. Do not attempt to cut PEEKsil tubing. 

 
 

 

Note: For NanoLC Ultra 1D+ and 2D+ systems, the loading pump channel will be 
connected to the autosampler for trap loading experiment. 

 
1. Place the seal rinse and waste bottle of the NanoLC Ultra system beside the AS-2 

autosampler. 

2. Remove the screw that is located at the lower middle of the AS-2 side cover using an 
appropriate screw driver. 

3. Secure the seal rinse and waste bottle by using the bottle bracket. Tighten the bracket 
to the screw hole located at the lower middle of the AS-2 side cover. 

4. Insert the waste tubing from the pumps to the waste bottle. 

5. Fill the seal rinse bottle with DI water and insert the seal rinse tubing (green) to the 
bottle. Make sure the tubing ends are submerged in the DI water. 
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6. Connect 50 µm ID PEEKsil tubing to the Gradient 1 outlet of the NanoLC Ultra using 
the ferrule, and nut. If using fused silica, cut the fused silica to an appropriate length. 
Make sure to use the capillary cutter to ensure a clean cut on the ends. 

7. Connect the other end of the 50 µm ID PEEKsil tubing to the Pump connection on the 
injection valve of the AS-2 using the 1/32 inch nuts and ferrules. Make sure the 
PEEKsil tubing is fully seated in the valve fitting. 

8. Connect the other piece of 50 µm ID PEEKsil to the Column port of the NanoLC AS-2 
injection valve to the 10-port switching valve using one of the plumbing diagrams 
shown in Appendix C. 

9. Open the Direct Control dialog (Figure 3-14) by clicking System > Direct Control 
from the Eksigent control software’s Acquisition window. 

 
Figure 3-14 Direct Control Dialog—Flushing Gradient 1 Autosampler 

Connection 
10. Set solvent A and B to 50/50 and Total flow rate to 20 µL/min. (for NanoLC 

Ultra-1D+ or 2D+, use 100%A). 

11. Click Start to flush the valve ports and PEEKsil tubing. Flush for 10 minutes. 

12. Stop the flow by clicking Stop. 
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Chapter 4.  
Getting Started 
Chapter 4 offers a brief tutorial which should be useful in understanding the normal operation of 
the NanoLC Ultra® system. The procedures described in this chapter presume the system has 
already been properly installed and initialized as described in chapters 2 and 3. Topics in this 
chapter include: 

• Power Up the System (Section 4.1) 
• Purge and Flush with New Solvents (Section 4.2) 
• Equilibrate the System(Section 4.3) 
• Using the temperature-controlled compartment (Section 4.4) 
• Create an Autosampler Method (Section 4.5) 
• Create an LC Method (Section 4.6) 
• Create the Run Table (Section 4.7) 
• Start the Run (Section 4.8) 
• View the Collected Data (Section 4.9) 

4.1 Power Up the System 
1. If the system is not already on, turn on the NanoLC Ultra system power switch (on the 

rear panel).  

The green LED on the front of the instrument should illuminate. 

2. If the autosampler is not already on, turn on the power switch on the NanoLC AS-2 
autosampler. 

3. Turn on the computer, log in to Windows and launch the Eksigent control software by 
double-clicking the software icon. 
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After initialization, the Acquisition window will be displayed (Figure 4-1). 

 
Figure 4-1 Acquisition Window 

 

Note: On multichannel systems, The NanoLC Ultra-1D plus, 2D and 2D plus 
instrument have two or three channels of fluid control. They are denoted in this 
manual and in the Eksigent control software as gradient 1, 2, and loading pump (refer 
to Table 3-1 for channel assignment). Throughout the software common windows are 
used to display or control these channels. To select the channel appropriate to that 
window (when available) click the Up or Down arrows next to the channel number 
display in the upper right of the window. 

 

4.2 Purge and Flush with New Solvents 
If solvent has been sitting for more than 2 weeks, the solvent should be replaced with fresh 
solvent, then purged and flushed. If the solvent is less than two weeks old, proceed to Section 
4.3. 

To discard old solvent in the mobile phase bottles, remove the bottle and pour out the old 
solvent. 

1. Pour new mobile phase into the bottle and insert the mobile phase transfer tubing and 
filters in the bottles. Purge the HPLC at least 10 times.  

Refer to Section 3.3 for a detailed procedure for purging the system. 

2. After the pump is thoroughly purged, flush the system. Select System > Mobile 
Phases from the main control window.  
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3. Click More and flush the system using 200 µL for Gradient 1 and Gradient 2.  

Refer to Section 3.3 for a detailed procedure for flushing the system. 

4.3 Equilibrate the System 
The Direct Control dialog (Figure 4-2) can be used to equilibrate the system following system 
power-up, a change of solvent or change of column. The injection valve can also be toggled 
between load and inject positions to flush the injection valve loop and interconnecting ports.  

1. Select System > Direct Control from the Acquisition window. 

 
Figure 4-2 Direct Control Dialog—Equilibrating the System 

2. Ensure that Conserved Flow is selected and set both A (%) and B (%) to 50.  

This will be the mobile phase composition used for equilibration. 

3. Set the Total flow rate to 300 nL/min or the appropriate flow rate. 

4. Click Start to start the pumps and begin equilibration. 

5. Flush the switching valve (or an injection valve connected directly to the NanoLC 
Ultra instrument) by alternately clicking the Load Position and Inject Position 
buttons in the Valve Direct Control area.  

6. Select Devices > Autosampler Device Settings in the Run Manager window.  
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7. Click of the Direct Control tab, then alternately click the Inject and Load buttons in 
the Injection Valve area to switch the valve in the NanoLC AS-2 autosampler (Figure 
4-3). 

 
Figure 4-3 Autosampler Configuration Dialog 

8. Allow the system to equilibrate for approximately 10 minutes. 

4.4 Using the Temperature-Controlled Column 
Compartment  

The 10-port column-switching valve is installed in the temperature-controlled column 
compartment (Figure 4-4). The column can be placed in the compartment to regulate the column 
temperature up to 40°C. 
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Figure 4-4 Front of the Instrument—Temperature-Controlled Column 

Compartment 
1. Turn the bezel knobs counter clockwise to take off the top front bezel. Place the bezel 

on top of the instrument. 

2. Make the capillary or PEEKsil connections from the NanoLC Ultra instrument to the 
NanoLC AS-2 autosampler and column.  

3. Flip open the bracket clips and insert the column in the groove (Figure 4-5). 

 
Figure 4-5 Column Mounting Bracket 

4. When finished, place the clips back to their original position. Place the connecting 
capillaries or tubing through the tubing passage. 

 

Tubing passage

Bezel knob

Temperature-Controlled 
Column Compartment

Tubing passage

Bezel knob

Temperature-Controlled 
Column Compartment

Bracket clips

Tubing 
passage

Bracket clips

Tubing 
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Note: Make sure all the connecting tubing is properly inserted in the tubing 
passage before closing the compartment. Failure to do so will damage or 
break the connecting tubing.

 
5. Place the bezel in front of the compartment to close the compartment. Make sure the 

latches are inserted properly to the chassis.  

6. Turn the bezel knob clockwise to secure the top bezel to the instrument. 

7. In the Direct Control dialog (Figure 4-6), set the Setpoint temperature. Click Start. 

 
Figure 4-6 Direct Control Dialog—Setting Column Compartment 

Temperature 
8. To disable or stop the temperature control, click Stop. 

 

Note: Do not operate the oven for an extended period of time without 
closing the compartment.

 

4.5 Create an Autosampler Method 
The parameters used for loading the sample into the valve and for rinsing the autosampler 
syringe and sample needle are stored in the autosampler method. This section will review an 
autosampler method appropriate for loading a trap with Gradient 1, and running a gradient with 
Gradient 2. 
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Note: Please read the following section carefully before proceeding to run the system 
with the AS-2 autosampler, especially if you have experience with the AS-1 
autosampler, as there are important changes in vial assignment and the method. 

 
1. Place the sample vial containing the standard test mixture in vial position B1 of the 

48-vial tray. 

Vial positions A1 to A4 on the left tray are reserved for Reagent 1 to Reagent 4. 

2. Click Run Manager in the Acquisition window to open the Run Manager window 
(Figure 4-7). 

 
Figure 4-7 Run Manager Window 

3. If you do not see a picture of the 48-vial tray in the Run Manager window, select 
Devices > Autosampler Device Settings to set the tray type. You will need to restart 
the Run Manager after changing the tray type. 

4. If you do not see the columns shown in Figure 4-7, select Edit > Choose Column 
and select the appropriate columns for display. 
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5. Click Autosampler Methods to display the Autosampler Settings dialog (Figure 
4-8).  

 
Figure 4-8 Autosampler Settings Dialog 

6. Select a method from the drop down method similar to the one above. Highlight the 
name of the method, rename it, and click Save to create a new method. 

All autosampler methods should contain the following steps in the same order. The 
volumes can be modified but the general format should remain the same for a given 
method type. In this example, a trap loading autosampler method is indicated: 

Table 4-1 Template for Micropickup Injection, Trap Loading Autosampler Method 
Step # Operation Vol. Parameter Speed  Height Description 

1 Valve   Injector Load   Place autosampler valve 
in load position 

2 Needle Wash 50µL    Perform 50µL needle 
wash 

3 Aspirate 21µL Reagent - 1 2 3 Aspirate from Reagent 1 
vial position 

4 Aspirate 1µL Sample 2 (2-5) Aspirate from Sample 
vial- use appropriate 
height for sample vial. 1= 
closest to bottom, 5= 5 
mm from bottom of vial. 
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Step # Operation Vol. Parameter Speed  Height Description 

5 Aspirate 3µL Reagent - 1 2 3 Aspirate from Reagent 1 
vial position 

6 External 
Events 

 Wait for 
Gradient 1 
Ready 

  Wait for Gradient 1 ready 
to start (after 
equilibrating) 

7 External 
Events 

 Start 
Gradient 1 

  Send signal to start 
loading method in 
Gradient 1 

8 Valve   Injector Inject   Place autosampler valve 
in the inject position (1-2) 

9 External 
Events 

 Wait for 
Gradient 1 
Inject 

  Wait for the injection from 
Gradient 1 to be 
completed 

10 Valve   Injector Load   Place autosampler valve 
in the load position (1-10) 

11 External 
Events 

 Start 
Gradient 2 

  Send signal to start 
gradient  method in 
Gradient 2 

12 Dispense  25µL Waste 5 0 Dispense aspirated 
volume to waste. Total 
aspirate and dispense 
volumes must be equal. 

13 Needle Wash 50µL    Perform 50µL needle 
wash 

14 End     Method end 

 

7. As needed, modify method steps and parameters. 

• To modify method steps, click the step and change the volume by typing over it. 
• Modify the operation or parameter by clicking the step and choosing a new value 

in the drop-down menu. 

8. As needed, add new steps by clicking >> to the left of the line.  

9. As needed, delete steps by clicking the X. 

 
Note: This method is for an autosampler configured with the standard 25 µL 
syringe. For an autosampler with a larger syringe, change steps 3 and 5 
accordingly. 

 
10. Click Save next to the name to store the method. 

11. Click OK to close the Autosampler Settings dialog. 
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4.6 Create an LC Method—Gradient 1 
The conditions used for separating the sample are stored in the LC method. LC methods are 
accessed for editing from the Run Manager window. 

1. Click LC Methods in the Run Manager window to display the LC Method Settings 
dialog (Figure 4-9). 

 
Figure 4-9 LC Method Settings Dialog—Summary Tab 

2. To create a new method, type a name for the method and click Save. 

3. Optionally, enter any column information appropriate for your experiment. This 
information is informational and stored with the LC method file. 
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4. Click the Run Conditions tab in the LC Method Settings dialog (Figure 4-10). 

 
Figure 4-10 LC Method Settings Dialog—Run Conditions Tab 

5. Put a check mark in the Pre-Run Flush column check box and specify a time of 0.1 
minutes to flush the column using 100% initial flow rate conditions. 

6. Select Standard: in the Sample Injection region. This will signal the autosampler to 
place the column-switching valve in the inject position for the duration of the Gradient 
1 run.  

7. Leave the check box for Post-Run Flush column empty.  

8. Click the Gradient Table tab to set the gradient parameters.  

9. Enter the flow rate, time and percentages of A and B that are appropriate (Figure 
4-11).  

• For a 2D system with the same mobile phase for Gradient 1 A and B, use 50% A 
and 50% B.  
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• For a 1D+ and 2D+ system, use 100% A. 

 
Figure 4-11 LC Method Settings Dialog—Gradient Table Tab 
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10. Click the Gradient Profile tab (Figure 4-12). 

 
Figure 4-12 LC Method Settings Dialog—Gradient Profile Tab 

11. The mobile phase composition can also be set by clicking and dragging points on the 
graph or by setting the % of A or B in the Profile Editor region. 

12. Once the method is complete, click Save to save the analysis method. 
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4.7 Create an LC Method—Gradient 2 
1. Click LC Methods in the Run Manager window 

2. To create a new method, type over the name of the method and click Save. 

3. Optionally, enter any column information appropriate for your experiment. This 
information is informational and stored with the LC method file. 

4. Click the Run Conditions tab in the LC Method Settings dialog to obtain the Run 
Conditions tab (Figure 4-13). 

 
Figure 4-13 LC Method Settings Dialog—Run Conditions Tab 

5. Put a check mark in the Pre-Run Flush column check box and specify a time of 0 
minutes to flush the column using 100% of the initial flow rate conditions. 

6. Select Standard: in the Sample Injection region. This will signal the 10-port valve to 
be placed in the inject position for the duration of the Gradient 2 run.  

7. Leave the check box for Post-Run Flush column empty.  

8. Click the Gradient Table tab to set the gradient parameters (Figure 4-14).  

9. Enter the gradient parameters you wish to run.  

• Add new steps by clicking >> (on the left of the table). 
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• Delete steps by clicking on the X.  
• Set the overall flow rate on the right side. 

 
Figure 4-14 LC Method Settings Dialog—Gradient Table Tab 
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10. Select the Gradient Profile tab to display the Gradient Profile dialog (Figure 4-15). 

 
Figure 4-15 LC Method Settings Dialog—Gradient Profile Tab 

11. Use the Gradient Profile tab to survey the gradient you created to make sure it is 
correct. The mobile phase composition can also be set by clicking and dragging 
points on the graph or by setting the % of A or B in the Profile Editor region. 

12. Once the method is complete, click Save to save the analysis method. Click OK to 
close the dialog. 
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4.8 Create the Run Table 
The run table ties together an autosampler and one or more LC methods with a sample vial and 
tray position. You can also enter descriptive information related to the sample or analysis. This 
section will create a run table to run two samples with a trap and elute method. 

1. If not already in the Run Manager window, click Run Manager (in the Eksigent control 
software’s Acquisition window). (Figure 4-1). 

2. Create a new, blank Run Table by selecting Edit > Erase Table (Figure 4-16). 

 
Figure 4-16 Creating a New Run Table 

3. Select File > Save As and type Trap Loading in the File name field.  

4. Click Save. 

5. In the first line of the Run Table, double-click the Autosampler Method field and 
select the autosampler method Ultra 1 microliter pickup Gradient 1.  

6. Enter 1 for the Tray and D01 for the Vial location.  

Alternatively, enter the vial location by clicking the location of the vial on the picture of 
the vial tray in the Run Manager window. 

7. Double-click LC Method and select Gradient 1 Trap Loading. Indicate Gradient 1 in 
the Channel column. 

8. In line 2, leave the autosampler method, tray and vial location blank. Double-click the 
LC Method field and select Gradient 2 15 min gradient. Indicate Gradient 2 in the 
Channel column. 

9. For each sample you wish to run, duplicate these two lines in succession.  
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In Figure 4-17, two sample injections are indicated. 

 
Figure 4-17 Run Manager Window—Two Samples 

10. Check all the lines you wish to run in the Run column.  

11. Run the sequence in Sequential mode.  

12. Optionally, click Flush/Equilibrate when Idle to start all the pumps if you wish. 

If you need to edit the first two lines, un-check Flush/Equilibrate. 

13. Now that the run table has been defined (Figure 4-16), save it by selecting File > 
Save. 

4.9 Start the Run 
Samples to be analyzed are selected by placing a check mark in the box to the right of the 
appropriate row numbers in the Run Table.  

Select Flush/Equilibrate when Idle to initiate the pre-run flush for the first method. With this 
option selected, the system will continue to flush at the end of the sequence. 

Initiate the sequence of analyses by clicking on Start. After the start button has been pressed, it 
will change to a red Stop button that can be used to abort the run at any point during the 
analysis. 

Once the flow rate has stabilized, the sample injection process will begin. For the Trap loading 
run table created in Section 4.8, Gradient 1 will run first, then Gradient 2 will start at the 
conclusion of the Gradient 1 run.  

While the run is in progress, the Acquisition window can display the specified flow profiles for 
solvents A and B as well as their actual flow rates (Qa and Qb). Traces can be added or deleted 
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from the display by clicking on System > Appearance in the Acquisition window (Figure 4-18) 
and selecting the desired items. 

 
Figure 4-18 Acquisition window—flow profiles 
To zoom in on a particular area of the chromatogram, click and drag a box around the area of 
interest to enlarge that area of the chromatogram. To zoom back out, right click and select Zoom 
Out or Back. 

Status information such as %A, %B and Time Remaining are also displayed at the bottom of the 
window during the run. Status bars at the top of the screen display the actual flow rate for pump 
A (Qa) and pump B (Qb) in nL/min, and pressure, in psi, for pump A (Pa), pump B (Pb) and 
column (Pc). 

4.10 View the Collected Data 
Previously collected data files can be re-opened, reviewed and re-processed. 

To view the data file collected from the first chromatogram, click File > Open and then select the 
data file.  

The NanoLC Ultra has an option to collect an external signal (such as a UV detector) through the 
A/D input on the 8-pin I/O connector. This data will be stored, along with the flow profile data, in 
the data file.  

The Eksigent control software also includes a data analysis package and this analysis can be 
applied to the collected A/D signal. Refer to the Eksigent Control Software User Guide for 
instructions on analyzing data files with the software. 
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Chapter 5.  
Routine Maintenance 
Chapter 5 describes the general procedures used to properly maintain the NanoLC® Ultra 
system. Topics included in this chapter include: 

• Recommended Maintenance (Section 5.1) 
• Dispose of Waste (Section 5.2) 
• Zero the Pressure Transducers (Section 5.3) 
• Autotune Flow Controllers (Section 5.4) 
• Calibrate the Flow Meters (Section 5.5) 
• Check Flow Stability (Section 5.6) 
• Clean and Inspect the Instrument (Section 5.7) 

 
Note: For NanoLC AS-2 autosampler maintenance, refer to Appendix D. 

 

5.1 Recommended Maintenance 
The NanoLC Ultra system is designed and built for long-term, robust use in an active laboratory 
environment. To ensure reliable performance, the following procedures should be performed at 
the specified interval. 

Table 5-1 Recommended Maintenance 
Task Frequency Refer To 

Changing the Mobile Phase As needed Section 3.2 
Zeroing pressure transducers Monthly Section 5.3 
Checking flow stability Quarterly Section 5.6 
Autotuning flow controllers As needed Section 5.4 
Waste disposal As needed Section 5.2 
Calibrating flow meters Quarterly Section 5.5 
Cleaning and inspecting system Quarterly Section 5.7 
Changing internal instrument filters Annually Contact AB SCIEX  
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5.2 Disposing of Waste 
The user must properly dispose of the contents of any effluent waste in an appropriate chemical 
waste container. For typical experiments, waste from the 10-port column-switching valve due to 
high flow sample loading will be collected in a waste vial. 

The pump purge waste container located on the left side of the NanoLC AS-2 autosampler will 
also need to be emptied periodically. Unscrew the thumbscrew holding the clamp around the 
waste bottle, remove the bottle from the clamp and unscrew the cap from the bottle. Pour the 
contents into an appropriate chemical waste container. 

 
WARNING! Biohazard: Follow appropriate safety procedures and local 
requirements when handling or disposing of waste chemicals. See the solvent 
manufacturer’s Material Safety Data Sheets (MSDS) for more information. 

 

5.3 Zero the Pressure Transducers 
Before zeroing the pressure transducers, it is advisable to open the outlet fittings from the mixing 
tees on all channels. This will ensure there is no residual pressure on the outlet of the system. 

 

Note: It is very important that the instructions below are followed precisely. Attempting 
to zero the pressure transducers while there is still residual pressure on the system will 
lead to inaccurate flow rates.

 
 

 

Note: For an autosampler configured with the standard 25 µL syringe. For an 
autosampler with a larger syringe, change steps 4 and 6 accordingly.
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1. Select System > Hardware Diagnostics to initiate the pressure transducer zeroing 
procedure to display the Hardware Diagnostics dialog (Figure 5-1). 

 
Figure 5-1 Hardware Diagnostics Dialog—Re-initialize Transducers  

2. Stop the system flow. 

3. Loosen the outlet fitting of the mixing tee to release all the residue pressure. 

4. In Auto-diagnose, check Re-Initialize Transducers. 

5. Click Start Diagnostics.  

A dialog will appear (Figure 5-2) warning that the procedure should only be performed 
if there is no residual pressure on the system. 

 
Figure 5-2 Residual Pressure Warning 
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6. Once the system indicates that it is at ambient pressure, click OK and a status 
window will indicate that auto-zeroing is in progress (Figure 5-3). 

 
Figure 5-3 Auto-zero Status Window 

7. When the auto-zeroing process is complete, exit the Hardware Diagnostics dialog 
and return to the Acquisition window. 

8. Repeat for all channels (if not conducted simultaneously). 

5.4 Autotune Flow Controllers 
The flow controller autotune should be run when needed to optimize the performance of the 
system. 

 

WARNING! Potential Instrument Damage: Damage can result from 
overpressure. Disconnect the capillary/PEEKsil tubing at the mixing tee prior 
to performing the auto tune procedure. 

 
 

1. When the Autotune button is selected in the Hardware Diagnostics dialog, the 
system’s response to changes in flow rate is monitored and adjustments are made to 
the controllers PID (proportional/integral/ derivative) loop. 

2. A dialog warns the user to disconnect any devices which could be damaged by high 
pressure (Figure 5-4). 

 
Figure 5-4 Autotune Alert Dialog 
The dialog is followed by a status window (Figure 5-5) that alert you that the system is 
preparing to Auto-tune and then another window indicating that autotuning is 
occurring. 
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These adjustments improve the system’s response time and flow rate accuracy. 

 
Figure 5-5 Autotune Status Windows—Pump A 

3. Upon completion, close the Hardware Diagnostics dialog and return to the main 
screen.  

4. Repeat for all channels (if not conducted simultaneously). 

 

Note: The slider below the Auto Tune Controllers button is used to change 
the pump time response. Moving the slider to the right will change the pump 
to respond faster (under-damped). Moving the slider to the left will change 
the pump to respond slower (over-damped).

 

5.5 Calibrate the Flow Meters 
Calibration of the flow meters consists of measuring the velocity of a liquid front in a tube of 
known diameter. Selecting “Calibrate Flow meters test” will display a dialog with step-by-step 
instructions for performing the test. 

 
Required Materials 

• Flow calibration assembly (PN 801-00063) for high flow rate channel (includes 20 µL 
pipettes) 

• Flow calibration assembly (PN 801-00064) for low flow rate channel (includes 5 µL 
graduated pipettes) 

 

 

Note: Make sure the system has been purged, flushed, and the pressure transducers 
are zeroed before proceeding to flowrate calibration. Failure to do so will result poor 
performance of the system. Refer to Sections 3.3 and 5.3.

 
 

 

Note: If calibrating the low flow channel using the 801-00063 assembly, you can save 
time by connecting the pipette to the system and prefilling the pipette to approximately 
5 µm before the first black line using either Direct Control or the Mobile Phases > 
Flush Now feature.
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1. Select System > Hardware Diagnostics from the Eksigent control software 
Acquisition window.  

2. Select Calibrate Flowmeter to display a dialog with step-by-step instructions for 
performing the test (Figure 5-6). 

 
Figure 5-6 Flowmeter Calibration Dialog 

3. Verify that mobile phases specified are correct.  

If incorrect, click Cancel to close the Flowmeter Calibration dialog. Make the 
necessary changes in the Mobile Phases window, repeat step 1 and then click Next. 

4. Attach the flow calibration assembly, with appropriate pipette to either the mixing tee 
or after the valve or column.  

Select the appropriate pipette size and flow rate for calibrating that channel (refer to 
Table 5-2).  

• Use 20 µL/division in the pipette size to set the calibration flow rate to 5 µL/min for 
the high flow channel. 

• Use1 µL/division in the pipette size to set the calibration flow rate to 500 nL/min 
for the low flow channel. 
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5. Click Next to start the flow in pump A.  

6. Enter the appropriate volume requested in step 3 of the Flow Calibration Window 
dialog (Figure 5-6). Wait until the liquid front travels to the black line mark on the 
pipette and press Start to begin timing. 

• For the high flow channel, time how long it takes for the liquid front to travel 20 µL.  
• For the low flow channel, time how long it takes for the liquid front to travel 2 µL.  

7. Press Stop when the fluid front reaches the end of the pipette (or the appropriate 
mark) and then click Next. If necessary, disconnect the calibration assembly and dry 
out the liquid inside the capillary.  

8. Repeat the measurement to calibrate the pump B flow meter. 

9. Verify that the instructions were followed exactly and that all values entered are 
correct and then click Finish. 

Use Table 5-2 to choose the proper calibration pipettes when calibrating the high flow and low 
flow channels of the NanoLC Ultra system. 

Table 5-2 Calibration Pipette Guide 
 High Flow Channel Low Flow Channel Loading Channel 

Calibrated Pipette Size 20 µL 1 µL/division  
(5µL total) 

20 µL 

Calibration Flow Rate 5 µL/min 500 nL/min 5 µL/min 
Calibration Volume 20 µL/side 2 µL/side 20 µL/side 

 

 
Figure 5-7 Flow calibration pipettes 
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5.6 Check Flow Stability 
The flow stability of the A and B pumps can be determined in a similar fashion to the procedure 
used for zeroing pressure transducers (as described in Section 5.3) by selecting the Check Flow 
Stability diagnostic test. Two screens will be observed during the running of the test (Figure 
5-8). Initially the process requires the controllers to stabilize for 60 seconds. This is then followed 
by a 30 second examination of the control. 

Step 1          Step 2 

 
Figure 5-8 Checking flow stability progression  
Repeat this for other channels. 

5.7 Clean and Inspect the Instrument 
1. Visually inspect the system fluidics and electronic connectors on a quarterly basis. 

Look for evidence of fluid leaks by checking all fluid connections and look for dried 
deposits that may indicate a slow leak. 

2. Identify and correct the source of any leaks if found. If a fluidic connection is broken, 
replace the fitting and re-flush the system. Inspect the new connection to ensure that 
no leaks are present. Dabbing a laboratory wipe around fluid connections is a good 
method to identify slow leaks. 
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Chapter 6.  
Diagnostics and 
Troubleshooting 
Chapter 6 describes the built-in diagnostic capabilities of the NanoLC® Ultra system along with 
the most common troubleshooting procedures. Topics covered in this chapter include: 

• Overview of hardware diagnostics (Section 6.1) 
• Calibration values (Section 6.2) 
• General troubleshooting guidelines (Section 6.3) 
• Troubleshooting checklist (Section 6.4) 
• Error messages and system alerts (Section 6.5) 

6.1 Overview of Hardware Diagnostics 
The NanoLC Ultra system includes a number of diagnostic capabilities designed to maintain 
peak system performance. The status bars and the text displayed in the Eksigent control 
software Acquisition window provide general diagnostic capability for routine operation. It is a 
good practice to keep track of Pc pressure readings for the desired chromatographic method. 
Running the Hardware diagnostics is part of routine instrument maintenance and should be 
performed in the following schedule: 

• Every month: Re-initialize pressure transducers 
• Every three months: Autotune the controllers 
• Every three months: Calibrate the flow meters 

Refer to Sections 5.3 through 5.5 for details on running these diagnostics. 

6.2 Calibration Values 
The Calibration Values tab of the Hardware Diagnostics dialog summarizes the current k values 
of the flow meter, the gain and zero offsets of pressure transducers and the PID parameters for 
the pumps. The values should be documented before and after as part of maintaining a good 
instrument log and changes should be noted. These values should be very similar from 
diagnostic to diagnostic; large changes can indicate a problem. 
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6.3 General Troubleshooting Guidelines 
When troubleshooting the NanoLC Ultra system, follow these safety practices: 

 

 

WARNING! Potential Instrument Damage: To avoid damaging electrical parts, 
do not disconnect an electrical assembly while power is applied to the system. 
Once the power is turned off, wait approximately 30 seconds before 
disconnecting an assembly. 

 
 

 

WARNING! Biohazard: When replacing tubing or fittings on the NanoLC Ultra 
system or the NanoLC AS-2 autosampler, exposure to solvents may occur. It 
is therefore recommended that appropriate safety procedures be followed and 
personal protective equipment be used, according to the applicable Material 
Safety Data Sheets supplied by the solvent vendor. 

 
 

 

WARNING! Potential Instrument Damage: There are no user serviceable 
components or assemblies inside the NanoLC Ultra system or the NanoLC 
AS-2 autosampler. Service of any internal parts or assemblies requires an AB 
SCIEX-trained Field Service Employee (FSE).

 
 
Caution: Potential Operator Injury: To prevent injury, always observe good laboratory 
practices when you handle solvents, change tubing, or operate the system. Know the 
physical and chemical properties of the solvents you are using (refer to the Material 
Safety Data Sheets for the solvents in use). 

 

The basic steps for NanoLC Ultra system troubleshooting are: 

1. Step back and look at the overall system. Is something obvious causing the problem? 
For example, is the instrument unplugged or improperly connected? 

2. Compare current system operation with the way the system operated before the 
problem started. Identify conditions (pressures, power settings, flow rates) that are 
different than they were when the system was operating normally. 

For example, if the output pressure is usually 500 psi with a certain method, is the 
system pressure currently in the same range, or drastically higher (possibly caused 
by a plug) or lower (possibly caused by a leak)? 

3. Identify in the order listed below the symptom that varies from normal system 
operation: 
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• System power on and initialization (initialization fails) 
• System diagnostics (flow stability, controller tuning) 
• Flow rate in each channel (high, low, erratic) 
• Output pressure (high, low, erratic) 

4. For each isolated symptom, identify a list of possible causes using the 
troubleshooting checklist below.  

The troubleshooting in Section 6.4 allows you to narrow down the possible causes of 
a symptom and find suggested corrective actions. 

5. If this process does not correct the problem, contact AB SCIEX Technical Support. 
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6.4 Troubleshooting Checklist 
Table 6-1 Troubleshooting Checklist 
Symptom Possible Cause Corrective Action 
System Initialization 
Power LED on front panel 
is not on. 

Power supply is not turn on 
 
No power at outlet 
 
Power LED has failed but 
system response OK 

Turn on the power supply. 
 
Repair electrical outlet. 
 
Contact AB SCIEX Technical 
Support for assistance. 

Front panel power LED is 
on but software fails to 
recognize the instrument’s 
presence. 

Communication error between 
computer and an LC system 

Verify that the instrument’s 
USB cable is securely 
connected to the computer’s 
USB port (refer to Section 2.7). 
Reboot computer and cycle 
power on instrument. 
Verify that the number 
assigned to the USB port is not 
greater than 16. If necessary, 
re-assign the USB port number 
in Control Panel.  
Contact AB SCIEX Technical 
Support for assistance. 

Loud hissing sound from 
the instrument 

Gas leaks from the gas inlet 
fitting 

Verify the tubing is connected 
properly to the gas fitting. 
Tighten the gas inlet fitting. 
Contact AB SCIEX Technical 
Support for assistance. 

Flow Control System 
System pressure (Pc) 
and/or pump pressures 
(Pa & Pb) show pressure 
even though the flow is off 
 

Pressure transducers zero 
offsets are incorrect 

Zero pressure transducers 
(refer to Section 5.3). 

No liquid out of waste line 
when purging 

Air trap in the pump 
Internal filters are plugged 
 
Leak in the system prior to the 
purge valve 
 

Prime and purge the pump 
(refer to Section 3.3). 
 
Contact AB SCIEX Technical 
Support for assistance. 
Check all connections. 
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Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Flow Control System (continued) 
Pump restrokes 
frequently-Pump has 
reached end of stroke error 
message occurs 

Air trapped in the pump 
 
 
Pump remains on long 
enough to prompt a re-stroke 
 
 
 
Check valve is leaking 
 

Prime and purge the pump 
(refer to Section 3.3). 
 
Check the duration of time 
between re-strokes to see if 
the pump re-stroke was 
appropriate. 
 
Contact AB SCIEX Technical 
Support for assistance. 

Pump does not restroke at 
the end of a run 

Pump restroke delay is too 
short 
 
Optical sensor is not working 
properly 

Contact AB SCIEX Technical 
Support for assistance. 
 
Contact AB SCIEX Technical 
Support for assistance. 

Pump flushes out quickly but 
does not deliver ~600 µL per 
stroke. 

Leak in instrument Contact AB SCIEX Technical 
Support for assistance. 

Purge output drips out slowly Internal filters are plugged Contact AB SCIEX Technical 
Support for assistance. 

Inability to reach desired flow 
rate 

Internal filters are plugged 
 
 
 
Flow rate setpoint too high for 
system back pressure 
 
Air pressure too low 

Contact local AB SCIEX 
Technical Support to replace 
internal filters. 
 
Reset flow rate to a lower 
level. 
 
Establish correct pressure 
(100 psi). 

No flow rate with 100% 
power indicated. System 
pressure (Pc) and pump 
pressures (Pa & Pb) are all 
low 

No gas to system 
 
 
 
System not properly primed 
and flushed 

Connect 100 psi clean, dry 
gas to the instrument’s gas 
inlet. 
 
Prime and flush system (refer 
to Section 3.3). 

 
 



Diagnostics and Troubleshooting 
 

 
NanoLC Ultra® Systems  Operator Guide 
76 of 145  April 2013 

Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Flow Control System (continued) 
System responds sluggishly 
when changing flow rates 

Incorrect mobile phase 
setting in software 
 
Pump controller is out of tune  

Check the Mobile Phases 
setting (refer to Section 3.3). 
 
Autotune flow controllers 
(refer to Section 5.4) 

Flow rate will not initialize at 
start of run 

Flow rate setpoint too high for 
system back pressure 
Erratic flow rate due to 
bubbles in system 
 
Unable to meet required flow 
rate within specified 
tolerance 
 
 
 
 
 
 
 
One or both of the Internal 
solvent filters may be 
plugged 

Reset flow rate to a lower 
level. 
Prime and flush system (refer 
to Section 3.3). 
 
Lower flow stabilization limit 
in the Instrument 
Configuration dialog (refer to 
Section 3.3). 
Run the flow stability 
diagnostic to verify flow 
control (refer to Section 5.6). 
Autotune flow controllers 
(refer to Section 5.4). 
 
Flush system if flow is 
unstable (refer to Section 
3.3). 
If flow is still unstable, 
calibrate the flow meters 
(refer to Section 5.5). 
Contact AB SCIEX Technical 
Support for assistance. 
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Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Flow Control System (continued) 
Flow rate will not stabilize 
during a run 

Erratic flow rate due to 
bubbles in system 
 
Incorrect mobile phase 
setting 
 
Pump controller is out of tune 
 
  
Flow temperature is not 
stable 

Prime and flush system (refer 
to Section 3.3). 
 
Check the mobile phases 
setting (refer to Section 3.3). 
 
Autotune flow controllers 
(refer to Section 5.4). 
 
Contact AB SCIEX Technical 
Support for assistance. 

Inaccurate flow rate with no 
signs of leakage 

Incorrect mobile phase 
setting in software 
 
Incorrect k-values 

Check the Mobile Phases 
setting (refer to Section 3.3). 
 
Perform flow meter 
calibration (refer to Section 
5.5). 

System pressure (Pc) is 
unusually low but flow rate is 
OK 
 

Loose connection after 
mixing tee 

Check all connections for 
leaks. 

System pressure (Pc) is low 
and the flow rate is OK but 
pump pressures (Pa & Pb) 
are high 

Incorrect k-values 
 
 
 
Flow module is plugged 

Perform flow meter 
calibration (refer to Section 
5.5). 
 
Contact AB SCIEX Technical 
Support for assistance. 

Excess flow noise Trapped gas in the pump 
 
 
Pump controller is out of tune 

Prime the pump (refer to 
Section 3.3). 
 
Autotune flow controllers 
(refer to Section 5.4). 
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Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Flow Control System (continued) 
Measured flow does not 
follow the flow profile 

Pump controller is out of tune 
 
 
Pump time response is set 
incorrectly 

Autotune flow controllers 
(refer to Section 5.4). 
 
Adjust the pump time 
response in Hardware 
Diagnostics (refer to Section 
4.7). 

Pa and Pb maximized to < 
12000 psi with 100% pump 
power. 

Incorrect gain setting for 
pressure 
 
 
 
 
 
Incorrect zero setting for 
pressure sensors  
 
 
Inline gas pressure too low 

Check the setting in the 
Calibration Values tab in 
Hardware Diagnostic menu 
(2800 for 14 000 psi 
transducers, refer to Section 
6.3). 
 
Check the setting in Service 
menu (should be 500, refer to 
Section 6.3). 
 
Check the gas pressure  
(~100 psi). 

Temperature-Controlled Column Compartment 
No air flowing out from the air 
deflector 

Fan is not working. Contact AB SCIEX Technical 
Support for assistance. 

Compartment responds very 
slowly when changing 
temperature  

Fan is not working. 
Thermistor is not secured at 
the right location 
Heater’s PID parameters 
were incorrectly set 
Heater is not functioning 
properly 
 

Contact AB SCIEX Technical 
Support for assistance. 

Temperature does not rise at 
all but the fan is running 

Heater does not function 
 

Contact AB SCIEX Technical 
Support for assistance. 

Faulty temperature reading Thermistor is not secured at 
the right location 
Thermistor is not connected 
properly 

Contact AB SCIEX Technical 
Support for assistance. 
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Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Autosampler 
Software does not recognize 
NanoLC AS-2 autosampler 
when Run Manager is started  

Communication error 
between computer and 
NanoLC AS-2 autosampler 
 
 
 
Software may be configured 
to use a different COM port 
 

Verify that the RS-232 cable 
is securely connected to the 
Communications port 
autosampler (refer to Section 
3.4). 
 
Verify that the software is 
configured for autosampler to 
connect to the correct COM 
port (refer to Section 2.8). 

The NanoLC AS-2 
autosampler does not trigger 
instrument to start a run 

Autosampler method does 
not trigger the correct channel 

Verify the autosampler 
method.  
Make sure the correct LC 
channel is selected in the 
method. If the autosampler 
method is created correctly 
and the autosampler still does 
not trigger the LC to start a 
run, contact AB SCIEX 
Technical Support for 
assistance. 

Software does not trigger the 
NanoLC AS-2 autosampler to 
switch valve position 

Autosampler method does 
not include triggering the 
valve 

Verify the autosampler 
method. 
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Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Column-switching valve 
Valve does not switch 
positions 

Valve is not configured in the 
Eksigent control software 
Valve is not connected to the 
actuator 
Valve is connected to the 
wrong channel 
 
Faulty actuator  

In the Instrument 
Configuration dialog, set 
valve as internal (refer to 
Section 2.8). 
 
 
 
Contact AB SCIEX Technical 
Support for assistance. 

No flow coming out from the 
port 

The valve is plumbed 
incorrectly 
 
 
The ports are plugged 

Verify the plumbing 
configuration and reconnect if 
needed (refer to Appendix C). 
 
Manually flush each port with 
cleaning solvent using a 
syringe. If flushing does not 
clean the port, contact AB 
SCIEX to replace the valve. 

System pressure (Pc) with no 
column connected is 
unusually high 

The ports are plugged 
 
 
 
 
 
The ends of fused silica 
connected to the port might 
be crushed or not cut properly 

Manually flush each port with 
cleaning solvent using a 
syringe. If flushing does not 
clean the port, contact AB 
SCIEX to replace the valve. 
 
Check the ends under a 
microscope. Cut the ends if 
needed. 

Fluid leaking from the valve Ferrule was not seated 
properly in the port 
 
 
Rotor seal is scratched 

Check the tubing connection 
and make sure the ferrule is 
seated properly. 
 
Contact AB SCIEX Technical 
Support for assistance. 
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Table 6-1 Troubleshooting Checklist (Continued) 
Symptom Possible Cause Corrective Action 

Inconsistent flow rate Internal leakage in the valve 
 
 
Valve tubing connections are 
not made correctly (gap/dead 
volume between sleeves and 
port) 
 
The ports are plugged 

Contact AB SCIEX Technical 
Support for assistance. 
 
Check tubing connections. 
Make sure the cuts at the end 
of the capillaries are square. 
 
 
Manually flush each port with 
cleaning solvent using a 
syringe, or contact your AB 
SCIEX FSE to replace the 
valve. 

Bubbles in the flow stream Bubbles trapped in the valve 
 
 
 
Valve tubing connections are 
not made correctly (gap/dead 
volume between sleeves and 
port) 

Attach a high restrictor at the 
port to flush out the trapped 
bubbles. 
 
Check tubing connection. 

System does not initiate an 
injection 
 

System flow is unstable 
 
 
 
Flow stabilization is set too 
low 
 
 
 
 
Autosampler is configured 
with wait for injection but the 
LC method is used with no 
injection 

Purge both pumps and 
re-equilibrate system (refer to 
Section 3.3). 
 
Set the Flow Stabilization 
Limit in the Instrument 
Configuration dialog to 
> 100 nL/ min (refer to 
Section 2.8). 
 
Change the LC method to 
with injection or change the 
autosampler method without 
wait for injection command 
(refer to Sections 5.3 and 
5.4). 
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6.5 Error Messages and System Alerts 
System alerts can be displayed by selecting View > System Logs > Alerts. These alerts (Figure 
6-1) are reminders of an action that needs to be taken such as to run the diagnostic tests or refill 
the reagent storage loops. Clicking Clear Alerts will erase all alerts.  

 

 

Note: Clicking Clear Alerts does not mean that the recommended alert action has 
been completed. 

 
 

 
Figure 6-1 System Alerts Dialog 
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Appendix A  
Spare Parts and Consumables 
Table A-1 Consumables—NanoLC Ultra Systems  
Part Number Description 

200-00301 1/32 inch SS union with short nuts and ferules 
200-00319 1/32 inch microtight union (includes fittings) 
200-00329 Mobile phase filter 
205-00048 20 mm ID /1/32 inch OD x 75 cm PEEKsil tubing (black) 
205-00049 50 mm ID /1/32 inch OD x 75 cm PEEKsil tubing (natural) 
205-00052 20 mm ID /1/32 inch OD x 15 cm PEEKsil tubing (black) 
801-00020 Replacement calibration pipettes, 20 µL, for 1-30 µL/min, 10/pkg 
801-00063 Flow rate calibration kit with 20 µL calibrated pipettes (10) for 1-30 µL/min 

flow rate 
801-00064 Flow rate calibration kit with 5 µL calibration pipettes (5) for 50-1000 nL/min 

flow rate 
801-00065 Accessories kit for NanoLC Ultra systems. Includes mobile phase bottles, 

calibration kits, fittings, capillary tubing and cables. 
910-00007 Replacement calibration pipettes, 5 µL, for 50-1000 nL/min, 10/pkg 
910-00085 1/32 inch nut (long) 10/pkg 
910-00086 1/32 inch nut (short) 10/pkg 
910-00087 1/32 inch ferrule 10/pkg 
910-00088 1/32 inch sleeve for 365 mm OD fused silica capillary 10/pkg 
910-00089 1/32 inch microtight fitting 10/pkg 
910-00090 1/8 inch Super flangeless nut 10/pkg 
910-00091 1/8 inch Super flangeless ferrule 10/pkg 
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Table A-2 Replacement Parts—NanoLC Ultra Systems 
Part Number Description 

100-00041 Fitting, air supply, 1/4 inch compression 
200-00024 0.02 inch ID/1/16 inch OD x 8 inch SS tubing 
200-00075 0.02 inch ID/1/16 inch OD x 4 inch SS tubing 
200-00076 0.02 inch ID/1/16 inch OD x 5 1/4 inch SS tubing 
200-00302 1/16 inch to 1/32 inch reducing adapter SS 
200-00303 1/16 inch to 1/32 inch reducing union SS 
200-00316 1/32 inch mixing Tee 
200-00332 Rotor for 10 000 psi 10-port valve (1/32 inch ports) 
200-00333 10 000 psi 10-port valve (1/32 inch ports) (does not include actuator) 
205-00038 50 mm ID /1/32 inch OD x 15 cm PEEKsil tubing (natural) 
205-00039 50 mm ID /1/32 inch OD x 20 cm PEEKsil tubing (natural) 
205-00040 50 mm ID /1/32 inch OD x 30 cm PEEKsil tubing (natural) 
205-00041 50 mm ID /1/32 inch OD x 50 cm PEEKsil tubing (natural) 
205-00042 100 mm ID /1/32 inch OD x 75 cm PEEKsil tubing (red) 
205-00043 100 mm ID /1/32 inch OD x 20 cm PEEKsil tubing (red) 
205-00044 100 mm ID /1/32 inch OD x 30 cm PEEKsil tubing (red) 
300-00000 Solvent waste/seal wash bottle, 250 mL 
300-00007 Internal air line, black, polyethylene, 18 inch 
300-00057 Solvent bottle 250 mL 
300-00058 Solvent bottle 100 mL 
400-00424 Pressure transducer Pa/Pb (14,000 psi) 
400-00448 Pressure transducer Pc (14,000 psi) 
400-00463 Connector, 10-pin electrical, I/O, green 
400-00464 Connector, 8-pin electrical, I/O, green 
800-00204 Purge valve 
800-00205 Solenoid manifold gradient pump 
800-00268 Pump sled gradient complete gradient 1 
800-00269 Pump sled loading pump complete 
800-00289 Solenoid manifold loading pump 
800-00290 Flow module loading pump 1-30 mL/min 
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Part Number Description 

800-00294 Flow module gradient 50-500 nL/min 
800-00310 EP controller 
800-00323 Pump sled gradient complete gradient 2 
800-00350 Flow module gradient 1-10 mL/min 
800-00360 High pressure filter 
801-00066 Check valve rebuild kit 
910-00001 Line, air supply, 25 feet, 1/4 inch 

 

Table A-3 Replacement Parts—NanoLC AS-2 Autosampler 
Part Number Description 

5016577 Sample needle union, black 
200-00334 Rotor seal for 1/32 inch 6-port injection valve (10 000 psi) 
200-00335 1/32 inch 6-port injection valve (10 000 psi) 
200-00072 Sample needle union, tan 
620-00064 Syringe 25 µL 
620-00147 Air needle 
620-00148 Sample needle 2.4 mL 
620-00149 Buffer tubing kit 
620-00150 Syringe valve 
620-00151 Wash bottle 250 mL 
620-00152 Vial rack 12 vials 
620-00153 Vial rack 48 vials 
910-00081 PEEKsil sample loop, 1 µL 
910-00082 PEEKsil sample loop, 10 µL 
910-00083 PEEKsil sample loop, 20 µL 

 

 

  



  Spare Parts and Consumables 
 

 
NanoLC Ultra® Systems  Operator Guide 
86 of 145  April 2013 

 

 



 

 
Operator Guide  NanoLC Ultra® Systems 
April 2013   87 of 145 

Appendix B   
External Interface 
B.1 Interface Connections 
Appendix B describes the external interface to other instrumentation in order to synchronize 
sample injection with data collection. The connector pin assignments are described below. The 
connectors are located on the rear panel of the NanoLC® Ultra system. 

 
Figure B-1 Rear Panel—External I/O Interface  
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B.2 Remote Interface 
An enlarged drawing of the External Interface Connectors (Figure B-2) shows the 10 lines that 
are available for the output and the 8 lines are available for the input. The active state for the 
output line (open or close) and input line (TTL high or TTL low) are defined in the Instrument 
Configuration dialog (Section 2.8). 

The output lines are contact closures that share a common line. The CMN is available on pins 
O1 and O10. When connecting more than one external device, make sure they can share the 
CMN line.  

Table B-1 Output Connections 
Line Name Description 

O1 Out CMN The Out CMN contact is a common for the output interface.  
O2 Not used For future expansion. 
O3 Not used For future expansion. 
O4 Not used For future expansion. 
O5 Not used For future expansion. 
O6 VLV out The VLV out contact closes when the valve moves from the Load 

position to the Inject position. Its active state is NOT software 
configurable. 

O7 Run out The RUN out contact is used to trigger an external device at the time 
the gradient is started. Its active state is configurable from within the 
Eksigent control software. The logic state changes at the beginning of 
the gradient (end of injection when using metered injection mode) and 
stays in on-state during gradient. 

O8 PRK out The PRK out contact changes state when the peak parking function is 
actuated. Its polarity is configurable from within the Eksigent control 
software. 

O9 RDY out The RDY out contact changes state when the pump is ready to start run 
(for example at end of pre-run flush). Its active state is configurable 
from within the Eksigent control software. 

O10 Out CMN The Out CMN contact is a common for the output interface.  

 
Figure B-2 External Interface Connectors –Output connector (left) and Input connector 

(right) 

O1 O2 O3  O4  O5  O6 O7 O8 O9 O10  I 1  I 2  I 3  I 4  I 5  I 6  I 7  I 8  
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The input lines are TTL input that share a system GND on Pins I5 and I6. The lines are pulled up 
to 5V when not connected to an external device. The A/D in is a single-ended input that uses the 
same system GND. All inputs need to be less than ±24V. 

Table B-2 Input Connections 
Line Name Description 

I1 Not used For future expansion. 
I2 Not used For future expansion. 
I3 PRK in The PRK in contact allows remote triggering of the peak parking function. 

The instrument will remain in the peak parking state until the contact’s state 
is changed. Its input polarity is configurable from within the Eksigent control 
software. 

I4 RUN in The RUN in contacts allows remote starting of a method. Its active state is 
configurable from within the Eksigent control software. The external trigger 
should be a pulse-type and does not need to be held in the trigger state. 

I5 GND The GND is a system ground connection used in combination with other 
input contacts. 

I6 GND The GND is a system ground connection used in combination with other 
input contacts. 

I7 Not used For future expansion. 
I8 A/D in The A/D in is a 24-bit A/D input for collecting the signal from an external 

detector using the NanoLC Ultra’s data system. The reading can be plotted 
in the main acquisition window and saved to a data file. Please refer to 
Section 2.8 to change the input range. 
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B.3 Connecting to Other Instruments 
For other autosamplers, the active state (TTL low = 0 V or TTL high = 5 V) can be set for most 
I/O connections in the Instrument Configuration dialog. It is important that the ground lead of the 
peripheral be connected to the ground connection on the NanoLC Ultra. In addition, use of the 
NanoLC AS-2 autosampler provides a number of additional I/O signals with additional 
programming flexibility. 

 

Note: For all of the configurations discussed in this document, it is assumed that all 
of the inputs and outputs are configured as contact closures that are active in the 
closed state. 

 

B.3.1 Other Autosamplers 
The NanoLC Ultra can be integrated with autosamplers from other vendors through the use of 
contact closures. A variety of configurations are possible using the inputs and outputs of the 
NanoLC Ultra system described above. One suggested configuration is described here. 

1. Set up the injection method and sample sequence using the autosampler interface 
(front panel or other software). 

2. Set up a matching sequence of chromatographic methods in the Run Manager 
window of the NanoLC Ultra and make sure that LC Wait for Contact Closure is 
checked under the System menu in the Run Manager window.  

3. Verify that the analysis time per sample (time between autosampler injections) in the 
autosampler method is long enough to allow for the NanoLC Ultra method run time 
plus any pre-run flush equilibration for the next run. 

4. Connect the inject marker out from the autosampler to the Run Input (pin I4) and 
Ground (pin I5) of the NanoLC Ultra system. 

5. Start the sequence by starting the Run Manager sequence and then the autosampler. 
After the autosampler initiates its own sequence for dispensing sample it will trigger 
the NanoLC Ultra system to start its chromatographic run. 

The NanoLC Ultra system also provides a Ready Out (pin O9) which can be used as an input to 
other autosamplers to synchronize runs and error check operation. 

 

Note: The optimized injection routines that can be utilized with the NanoLC AS-2 
autosampler will, in general, not be available with other autosamplers. While the rapid 
inject or metered injection routines of the NanoLC Ultra method can be used to 
increase the flow rate during sample loading, one will not be able to switch the sample 
loop out of the flow path during the gradient. The may lead to significantly increased 
gradient delay times and decreased response times of the system. 
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B.3.2 Triggering MS Data Collection 
While integrated control of the NanoLC Ultra system using the Xcalibur, Analyst and Hystar 
software packages is available, other MS systems will allow synchronization of data collection 
through the use of contact closures. The following describes the general configuration for this 
synchronization. 

1. In the MS software package, choose the option to start data collection with an 
external contact closure. This can be applied for a single MS run or to a sequence or 
batch of data collection methods. When conducting multiple runs in a sequence table, 
please configure the Run Manager of the Eksigent control software with the 
corresponding sequence of methods. 

2. Set the Run Output configuration to contact closure (box checked) in the NanoLC 
Ultra software (menu). 

3. Identify the hardware interface for the MS contact closure input. This is typically either 
a terminal block mounted on the side of the MS instrument, or a pair of wires in an 
interface cable supplied with the MS. 

4. To synchronize MS data with the beginning of the gradient (after the injection), 
connect the Run Out (pin 07) and the Ground terminals to the MS contact closure. If 
one lead of the MS trigger is ground, make sure to connect it to the Ground 
connection of the NanoLC Ultra. For most applications, this connection will be made 
to the Gradient 2 (low flow gradient) side of the instrument. 

As an alternative, you can also choose to synchronize MS data with the beginning of 
the injection. To do this, connect the Valve Out (pin O6) and the Ground terminals to 
the MS contact closure. 

B.3.3 Triggering Peak Parking 
Peak parking on the NanoLC Ultra system can be triggered externally using the back panel I/O 
connectors. Connect the ground of the triggering contact closure to a Ground terminal on the 
back panel and connect the second wire of the contact closure to the Park In terminal (pin I3). 
The Park Out terminal (pin O8) can also be used to monitor the state of Peak Parking. The Peak 
Parking Toolbox window in the Eksigent control software (View > Toolboxes >PeakPark 
Toolbox) is used to configure the peak parking flow rate, flow rate reference (typically “column”’), 
and provide for hold and lockout times on triggering. 

Peak Parking can be configured on ThermoFinnigan MS systems that provide a configurable 
contact closure output. This variable contact closure can be configured in the Xcalibur software 
to be activated based on selected criteria including ion intensities and ion inclusion lists. A 
number of systems may also allow a fixed time or duration contact closure that can be configured 
in the MS software to trigger peak parking. These may be useful for well-defined experiments 
that will benefit from peak parking at a known time (not MS-dependent signals). 
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B.3.4 Ready Out  
When using the NanoLC AS-2 autosampler, one can also handshake with other components, 
such as a MS detector, using the Ready Out from that device. This will allow the LC queue to 
stop if the peripheral is not ready.  

To do this, connect the Ready Out from the peripheral to the In 1 (red wire in the 4-wired cable) 
and Gnd (orange wire in the 4-wired cable) of the AS-2 I/O cable. Add the following line to the 
beginning of the AS-2 method. 

‘Wait for Input 1-LOW’ 

 

Note: If the Ready Out from the peripheral is a TTL high trigger instead of TTL low or 
contact closure, change the line to 1-HIGH. 

 
The autosampler method will not proceed beyond the first line until it has received a ready signal. 
If you disconnect the peripheral, be sure to remove this line from the autosampler method or to 
short In 3 to ground. 
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Appendix C  
Quick Start Guides 
C.1 Introduction 
This document describes how to start up and run an installed NanoLC® Ultra system. Basic 
instrument operation is described, as well as some common configurations of the NanoLC Ultra 
system. It is not intended as a substitute for, but an addition to the training you will receive from 
your AB SCIEX Field Service Employee. 

 
Note: Use the example methods provided for the NanoLC Ultra system you have. 

 

C.2 Site Requirements 
Gas Requirements: 

• Air or nitrogen gas, clean and dry, regulated to 100 psi. 
• 1/4 inch tubing connection for the gas line.  

Power Requirements: 

• Please provide surge protector or UPS outlets. 
• 100-240V AC, 4 outlets necessary for the NanoLC-Ultra and autosampler, monitor 

and PC. 

User-Supplied Computer Requirements:  

• Windows XP Operating system 
• Re-writable CD-ROM drive; 1.44 MB floppy disk drive. 
• 2.8 GHz Pentium 4 processor; 512 MB RAM; 40 GB hard disk drive.  
• 1 USB port 

Bench Space: 

• 14 inch x 24 inch x 14 inch (W x D x H) 
• Up to 120 lbs with autosampler, depending on configuration 

New, bottled UV-grade Mobile Phase: 

• Water and acetonitrile with 0.1% formic acid are required 
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• IPA – 250 mL required 

C.3 Starting Up 
Follow this procedure to start a NanoLC Ultra system that has been idle or shut off a period of 
time. 

1. Check gas supplies: ensure the gas is turned on, and set to 100 psi. 

2. Check solvent level.  

If solvent has been sitting for more than 2 weeks, the solvent should be replaced with 
fresh solvent, then purged and flushed. If the solvent is less than two weeks old, 
proceed to step 4. 

 

Note: Replacing mobile phase is a 2-step process. First purge and then 
flush. 

 
To purge the pumps, click System > Mobile Phases.  

 
Figure C-1 Mobile Phases Dialog 
Click More to reveal the purging menu. 

 
Figure C-2 Mobile Phases Dialog, Showing Additional Options 
Purge all pumps at least 20 times to completely change the mobile phase. 

All pumps 
can be 
purged at 
the same 
time 
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3. Once new mobile phase is purged, flush the pump. Disconnect the pump outlet to 
prevent high pressure in the columns or traps. Flush all capillary flow rate pumps at 
65 µL/min for 200 µL, and all nano flow rate pumps at 6500 nL/min for 200 µL. 

 

Note: The flush is very important when changing mobile phase composition. 
Make sure to allow the pump to flush fully. 

 
4. Re-initialize pressure transducers often to ensure reproducible gradient formation.  

This functions to establish the zero point of the pressure transducers, so make sure 
there is no backpressure on the pump outlet before beginning by turning the pump off 
and loosening the pump outlet.  

To reinitialize the transducers, click System > Hardware Diagnostics.  

Check the box and click Start Diagnostics.  

Click Yes to run on all channels. 

 
Figure C-3 Hardware Diagnostics Dialog 

5. Reconnect pump outlets, and establish flow to the column and trap: 

• Click System > Direct Control. 
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• Set desired flow rate and click Start. 

 
Figure C-4 Direct Control Dialog 

Set flowrate and 
%A/%B 

Click Start 
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C.4 NanoLC Ultra 1D+ System Methods 
 

 
Note: Use the example methods provided for the NanoLC Ultra system you have. 

 
 

C.4.1 Direct-to-Column Injection 

 
Figure C-5 Plumbing Diagram—Direct-to-column Injection for the NanoLC Ultra 1D+ 

System 

Grad 1

hν

MS Source

20-25 micron I.D. tubing

Direct to column injection

Grad 1

hν

MS Source

hνhν

MS Source

20-25 micron I.D. tubing

Direct to column injection
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Figure C-6 Autosampler Method—Direct-to-column Injection for the NanoLC Ultra 1D+ 

System 
 

  

 
Figure C7 Gradient 1 Method—Direct-to-column Injection for the NanoLC Ultra 1D+ 

System 
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Figure C-8 Sequence Setup—Direct-to-column Injection for the NanoLC Ultra 1D+ 

System 



Quick Start Guides 
 

 
NanoLC Ultra® Systems  Operator Guide 
100 of 145  April 2013 

C.4.2 Single Trap Loading 

 
Figure C-9 Plumbing Diagram—Single Trap, Unidirectional Flow for the NanoLC Ultra 

1D+ System 
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Figure C-10 Autosampler Method—Single Trap, Unidirectional Flow for the NanoLC 

Ultra 1D+ System 
 

  

 
Figure C-11 Loading Pump Method—Single Trap, Unidirectional Flow for the NanoLC 

Ultra 1D+ System 
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Figure C-12 Gradient 1 Method—Single trap, Unidirectional Flow for the NanoLC Ultra 

1D+ System 
 

 
Figure C-13 Sequence Setup—Single Trap, Unidirectional Flow for the NanoLC Ultra 1D+ 

System  
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C.4.3 Single Trap Bidirectional Flow 
Bidirectional trap and vented column method programming is the same as above trap loading 
methods. 

 
Figure C-14 Plumbing Diagram—Single Trap, Bidirectional Flow for the NanoLC Ultra 

1D+ System 
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C.4.4 Vented Column 
Bidirectional trap and vented column method programming is the same as above trap loading 
methods. 

 
Figure C-15 Plumbing Diagram—Vented Column Injection for the NanoLC Ultra 1D+ 

System 
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C.4.5 Dual Trap 

 
Figure C-16 Plumbing Diagram—Dual Trap Injection for the NanoLC Ultra 1D+ System 
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C.5 NanoLC Ultra 2D System Methods 
 

 
Note: Use the example methods provided for the NanoLC Ultra system you have. 

 
 

C.5.1 Direct-to-Column Injection 

 
Figure C-17 Plumbing Diagram—Direct-to-column Injection for the NanoLC Ultra 2D 

System 
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Figure C-18 Autosampler Method—Direct-to-column Injection for the NanoLC Ultra 2D 

System 
 

  

 
Figure C-19 Gradient 2 Method—Direct-to-column Injection for the NanoLC Ultra 2D 

System 
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Figure C-20 Sequence Setup—Direct-to-column Injection for the NanoLC Ultra 2D 

System 
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C.5.2 Single Trap 

 
Figure C-21 Plumbing Diagram—Single Trap, Unidirectional Flow for the NanoLC Ultra 

2D System 
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Figure C-22 Autosampler Method—Single Trap, Unidirectional Flow for the NanoLC 

Ultra 2D System 
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Figure C-23 Gradient 1 Method—Single Trap, Unidirectional Flow for the NanoLC Ultra 

2D System 
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Figure C-24 Gradient 2 Method—Single Trap, Unidirectional Flow for the NanoLC Ultra 

2D System 
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Figure C-25 Sequence Setup—Single Trap, Unidirectional Flow for the NanoLC Ultra 2D 

System 
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C.5.3 Single Trap Bidirectional Flow 
Bidirectional trap loading and vented column methods are the same as the above trap loading 
method. 

 
Figure C-26 Plumbing Diagram—Single Trap, Bidirectional Flow for the NanoLC Ultra 2D 

System 
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C.5.4 Vented Column 
Bidirectional trap loading and vented column methods are the same as the above trap loading 
method. 

 
Figure C-27 Plumbing Diagram—Vented Column Injection for the NanoLC Ultra 2D 

System 
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C.5.5 Dual Trap 

 
Figure C-28 Plumbing Diagram—Dual Trap Injection for the NanoLC Ultra 2D System 
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C.5.6 Dual Column 

 
Figure C-29 Plumbing Diagram—Dual Column Injection for the NanoLC Ultra 2D System 
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C.6 NanoLC Ultra 2D+ System Methods 
 

 
Note: Use the example methods provided for the NanoLC Ultra system you have. 

 
 

C.6.1 Direct-to-Column Injection 

 
Figure C-31 Plumbing Diagram—Direct-to-column Injection for the NanoLC Ultra 2D+ 

System 

 

Note: Depending on your configuration, direct injection can be done with gradient 1 or 
gradient 2.
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Figure C-32 Autosampler Method—Direct-to-column Injection for the NanoLC Ultra 2D+ 

System 
 

  

 
Figure C-33 Gradient 1 Method—Direct-to-column Injection for the NanoLC Ultra 2D+ 

System 
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Figure C-34 Sequence Setup—Direct-to-column Injection for the NanoLC Ultra 2D+ 

System 
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C.6.2 Single Trap Loading 

 
Figure C-35 Plumbing Diagram—Single Trap, Unidirectional Flow for the NanoLC Ultra 

2D+ System 
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Figure C-36 Autosampler Method—Single Trap, Unidirectional Flow for the NanoLC 

Ultra 2D+ System 
 

  

 
Figure C-37 Loading Pump Method—Single Trap, Unidirectional Flow for the NanoLC 

Ultra 2D+ System 
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Figure C-38 Gradient 1 Method—Single Trap, Unidirectional Flow for the NanoLC Ultra 

2D+ System 

 
Figure C-39 Sequence Setup—Single Trap, Unidirectional Flow for the NanoLC Ultra 2D+ 

System 
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C.6.3 Single Trap Bidirectional Flow 
Bidirectional trap and vented column method programming is the same as above trap loading 
methods. 

 
Figure C-40 Plumbing Diagram—Single Trap, Bidirectional Flow for the NanoLC Ultra 

2D+ System 
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Bidirectional Trap 
Bidirectional trap and vented column method programming is the same as above trap loading 
methods. 

 
Figure C-41 Plumbing Diagram—Bidirectional Trap Injection for the NanoLC Ultra 2D+ 

System 
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C.6.4 Dual Trap 

 
Figure C-42 Plumbing Diagram—Dual Trap Injection for the NanoLC Ultra 2D+ System 
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Appendix D  
NanoLC™ AS-2 Autosampler 
Maintenance 
Aspiration issues with the NanoLC AS-2 autosampler are usually caused by a restriction in the 
aspiration path. This chapter contains a maintenance schedule for the autosampler and 
describes how to test for and solve aspiration issues. 

D.1 Maintenance Schedule 
Table D-1 Maintenance Schedule 
Maintenance Procedure Frequency 

Perform an initial wash, using the Autosampler Configuration dialog. Daily 
Change the Reagent-1 solution and refill to the proper level (on most vials, 
this level is indicated by blue wavy lines printed on the vial). 

Weekly 

Fill the wash solution with degassed 20% isopropanol in water. Monthly 

D.2 Test the Aspiration Path 
The autosampler uses a syringe to aspirate liquid through the sample needle and into the sample 
loop. If a clog or damage to one of the components in the aspiration path occurs, then the 
autosampler may aspirate less than the programmed volume. 

Symptoms of a restriction in the aspiration path include lower than expected signal intensity, air 
bubbles in the autosampler syringe or aspiration volumes less than the programmed volume. 
Each of these symptoms can result from a clog or restriction in the aspiration path. 
When an aspiration issue is suspected, test the aspiration of the autosampler. During this test, a 
sample vial is weighed before and after aspiration and the volume aspirated is calculated and 
compared to a theoretical value. When the actual aspiration is less than the theoretical volume, 
there is an aspiration issue. 
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Required Materials 

• Pipettor 
• Small vial 
• Water 
• Balance capable of accurately weighing 5 mg (0.005 g) or less 

1. Pipette 25 μL water into a sample vial. 
2. Weigh the vial. 
3. Place the vial in the autosampler tray or rack. 
4. Perform an initial wash to remove any air bubbles in the syringe: 

a. In the Run Manager window of the Eksigent control software, click Devices > 
Autosampler Device Settings to open the Autosampler Configuration dialog. 

b. In the Autosampler Configuration dialog, click the Direct Control tab. 

c. In the Initial Wash group, click Start. 
It may be necessary to replace the wash solution with 100% isopropanol to more 
effectively remove bubbles. Also, air may need to be removed from the syringe by 
removing the syringe and flushing it with clean wash solvent. 

5. Run a method that aspirates 5 μL of sample from the vial.  

For an example, refer to Figure D-1. 
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Figure D-1 Autosampler Settings Dialog–AS-2 Aspiration Test Method 

6. When the aspiration is complete, weigh the vial. 
7. Subtract the post-aspiration weight from the initial weight.  

5 μL of water weighs 5 mg (0.005 g) and a difference of 4.4 mg to 5.6 mg is 
acceptable. 
If the weight difference is less than 4.4 mg, then there may be a clog in the aspiration 
path. The most common sites for a restriction of the aspiration path are: 

• Sample needle, including union 
• Buffer tubing 
• Valve, including the stator and rotor seal 
• Sample loop 
• Syringe 
• Syringe valve 

Follow the procedures below to test and, if needed, replace the components of the aspiration 
path. 
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D.3 Test the Sample Needle 
The most common source of a clog in the aspiration path is in the sample needle or the sample 
needle union. This test describes how to assess the sample needle for a clog, and how to isolate 
the issue to the sample needle union, as appropriate. 

1. Remove the sample needle from the autosampler (refer to “Replace the Sample 
Needle”). 

2. Attach the sample needle to the outlet of the high-flow pump. Depending on the exact 
configuration of LC, this is most commonly the loading pump or Gradient 1. 

3. In the Eksigent control software Acquisition window, select System > Direct 
Control to display the Direct Control dialog.  

4. In the Direct Control dialog, start flow through the needle at 10 μL/min. If using a 
gradient channel, use 95% A. 

5. In the Acquisition window, observe Pc. 

• If Pc is less than 5 psi, the sample needle and union are not clogged. If there is an 
aspiration issue, the issue is probably in another part of the aspiration path.  

• If Pc is greater than 5 psi, the sample needle or union may be clogged. Replace 
the sample needle union. Use either of the following unions: 
• Black 150 µM ID union, (PN 5016577) 
• Tan microtight union (PN 200-00072) 

6. After the replacement union is installed, start flow and observe Pc.  

• If Pc is less than 5 psi, reinstall the sample needle and retest the aspiration. 
• If Pc is still greater than 5 psi, follow the instructions below to replace the sample 

needle.  

D.3.1 Replace the Sample Needle 
Follow this procedure to replace the sample needle. 

Required Materials 

• Sample needle (PN 620-00148) 

1. In the Run Manager window of the Eksigent control software, click Devices > 
Autosampler Device Settings to open the Autosampler Configuration dialog. 

2. Click the Direct Control tab. 
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3. Click Needle Exchange and follow the on-screen instructions (Figure D-2). 

 
Figure D-2 Autosampler Configuration Dialog Indicating the Needle 

Exchange Button 
4. Wait for the autosampler to move the needle to the exchange position. 
5. Disconnect the sample needle from the 6-port valve. 
6. Gently push the sample needle out of the retaining clip, if present (Figure D-3). (The 

retaining clip is not present on all NanoLC AS-2 autosamplers.) 



NanoLC™ AS-2 Autosampler Maintenance 
 

 
NanoLC Ultra® Systems  Operator Guide 
132 of 145  April 2013 

7. Unscrew the air nut by rotating it counter-clockwise (Figure D-3). 

 
Figure D-3 Sample Needle Retaining Clip (Arrow) and the Air Nut (Circle) 

8. Pull up on the sample needle to remove it from the sample needle assembly. 
9. Insert a new needle into the sample needle assembly. There is a small hole into 

which the needle is inserted that is nearly impossible to see, so do this by feel. 
10. Tighten the air nut finger tight. Take care to not cross-thread the nut. 
11. Fasten the metal clip around the sample needle, if the clip is present. 
12. Connect the sample needle to the 6-port valve. 
13. Click OK after the needle has been exchanged. 
14. Perform an initial wash to remove air from the new sample needle: 

a. In the Autosampler Configuration dialog, click the Direct Control tab. 

b. In the Initial Wash group, click Start (Figure D-9). 

15. Click OK to close the Autosampler Configuration dialog. 
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16. Perform an aspiration test (refer to “Test the Aspiration Path”). 

D.4 Replace the Buffer Tubing 
The second most common place for a restriction in the aspiration path is in the buffer tubing. The 
buffer tubing runs between the 6-port valve and the syringe valve (located above the syringe). 
This tubing is very thin-walled and easy to damage by kinking, crimping, or bending.  

Inspect the buffer tubing for any damage, paying special attention to the location where the 
tubing connects to the syringe valve and where it connects to the 6-port valve (Figure D-4).  

 
Figure D-4 Location of Buffer Tubing Connections 
If the buffer tubing needs replacement, take care to not damage the replacement tubing.  

Required Materials 

• Replacement tubing set with fittings (PN 620-00149) 

1. Remove the butter tubing. 

a. Remove the blue fitting for the buffer tubing from the front of the syringe valve. 

b. Remove the finger-tight fitting for the buffer tubing from the 6-port valve. 
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c. Remove the buffer tubing from the autosampler. 

2. Place a finger-tight fitting one end of the buffer tubing. 

3. Place a small PEEK ferrule on the tubing as shown in Figure D-5. 

 
Figure D-5 Buffer Tubing Fittings at the 6-port Valve 

4. Carefully place the tubing, ferrule, and fitting into the 6-port valve and tighten 
finger-tight. 

5. Insert a blue fitting onto the other end of the new buffer tubing. 

6. Insert the tubing carefully into the conical end of a new white ferrule as shown in 
Figure D-6.  

Make sure that the tubing does not pass through the ferrule and out of the flat end of 
the ferrule. Do not try to force the tubing through the ferrule; it does not fit and the 
tubing will be damaged. 

 
Figure D-6  Buffer Tubing Fittings at the Syringe Valve 

7. Insert the fitting and ferrule into the front port of the syringe valve and tighten 
finger-tight. 

8. Perform three Initial Wash cycles to clear the new buffer tubing of air. 

9. Perform an aspiration test (refer to “Test the Aspiration Path”). 
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D.5 Replace the Rotor Seal and Stator 
The stator is the front portion of the valve, containing the ports. The rotor seal is behind the stator 
and forms the liquid seal between the ports of the valve. If either of these parts is damaged, then 
aspiration or sample delivery issues can occur.  

Required Materials 

• To replace the seal and the stator: 6-port valve, includes valve body, rotor seal, and 
stator (PN 200-00335)  

or 

• To replace only the rotor seal: rotor seal (PN 200-00334)  
• Sonicator 
• Methanol 
• 9/64 inch hex wrench 

1. Remove all fittings from the valve 

2. Using a 9/64 in hex wrench, remove the two stator bolts. 

3. Carefully remove the stator from the valve body (Figure D-7). 

4. Carefully remove the rotor seal from the valve body (Figure D-7).  

 
Figure D-7 Six-port Valve Components 

5. Inspect the rotor seal and stator for damage or wear. 
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6. If the stator is not to be replaced, sonicate it in 100% methanol for 10 minutes with the 
sealing side (the side that contacts the rotor seal) up (refer to Figure D-7). 

7. Replace the rotor seal with the new one.  

a. Position the rotor seal so that the sealing side faces out, away from the valve body 
(Figure D-8).  

b. Align the tabs on the rotor seal with the notches in the valve rotor and carefully 
press into place. 

 
Figure D-8 Rotor Seal Details–Front, Sealing Side (a), and Back, Non-sealing 

Side (b) 
8. Align the stator so that the bolt holes align and the pins fit into the pin holes and press 

the stator onto the valve body. 

9. Place one of the bolts into the bolt hole and tighten until the bolt until slight resistance 
is felt. 

10. Place the other bolt into the bolt hole and tighten until the bolt cannot go any further. 

11. Tighten the first bolt completely. There are built-in stops so that the stator cannot be 
over-tightened. 

12. Inspect the gap between the valve body and the stator. There should not be a gap. 

13. Replace the fittings on the valve. 

14. Switch the valve position between inject and load ten times. 

a. In the Autosampler Configuration dialog, click the Direct Control tab. 
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b. In the Injection Valve group, click Inject then Load (Figure D-9). Repeat until the 
valve has been switched ten times. 

 
Figure D-9 Autosampler Configuration Dialog Indicating the Injection Valve 

Position Buttons 
15. In the Initial Wash group, click Start (Figure D-9) to perform an initial wash. 

16. Click OK to close the Autosampler Configuration dialog. 

17. Perform an aspiration test (refer to “Test the Aspiration Path”). 

 

Note: If both the rotor seal and the stator were replaced, the new valve body will 
be left over. 
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D.6 Replace the Syringe 
Another possible source of aspiration issues is the autosampler syringe, as this wears over time.  

 

Note: Do not assume that the syringe needs replacement because there are air 
bubbles in the syringe. Air bubbles can mean that there is a restriction somewhere 
else in the aspiration path. 

 
Required Materials 

• 25 μL syringe (PN 620-00064) 
• Small screwdriver 
• Plastic pipette tip 

1. Move the syringe to the end position. 

a. In the Autosampler Configuration dialog, click the Direct Control tab. 

b. In the Syringe Position group, click End (Figure D-10). 

 
Figure D-10 Autosampler Configuration Dialog Indicating the Syringe Position 

Buttons 
2. Remove the wash bottle from the front of the autosampler. 

3. Carefully pull the plunger out of the plunger clip (Figure D-11).  
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A small slotted screwdriver can be used to help pry the plunger from the clip. 

4. Remove the syringe from the syringe valve by rotating the top of the syringe 
clockwise (Figure D-11). 

 
Figure D-11 Syringe Assembly Indicating the Plunger Clip (Circle) and Top of 

Syringe (Arrow) 
5. Inside the syringe valve, use a plastic pipette tip to carefully remove the white Teflon 

seal. Be careful to not damage the syringe valve. 

6. Fill the new syringe with the wash solvent, leaving a small amount of liquid on the tip 
of the syringe. 

7. Clip the plunger into the plunger clip. 

8. Place a new Teflon seal (included with the new syringe) on top of the syringe and 
carefully insert the syringe into the syringe valve. 

9. Tighten the syringe finger-tight by rotating the top of the syringe counter-clockwise. 

10. Perform several initial washes to clear any air in the syringe. 

a. In the Autosampler Configuration dialog, click the Direct Control tab. 

b. In the Initial Wash group, click Start (Figure D-10). 



NanoLC™ AS-2 Autosampler Maintenance 
 

 
NanoLC Ultra® Systems  Operator Guide 
140 of 145  April 2013 

11. Perform an aspiration test (refer to “Test the Aspiration Path”). 

D.7 Replace the Sample Loop 
Another component of the aspiration path that can clog and lead to aspiration issues is the 
sample loop.  

Required Materials 

• 10 μL Sample loop (PN 910-00082) 

1. Remove the sample loop from the 6-port autosampler valve. 

2. Insert one end of the new sample loop into port 2 of the autosampler and tighten the 
nut. Leave the other end free. 

3. Click Inject in the Autosampler Configuration dialog to switch the valve to the inject 
position (Figure D-9). 

4. In the Direct Control dialog, start flow on the channel connected to port 1 of the 
autosampler (depending on the LC configuration, this is usually the loading pump or 
gradient 1). The flow rate depends on the channel: 

• For a micro-flow channel (such as the loading pump)–10 μL/min.  
• For a nano-flow channel–1000 nL/min. 

5. Observe the free end of the sample loop for liquid. When liquid appears from the free 
end of the sample loop, lower the flow rate to a rate appropriate for any downstream 
connections, typically: 

• 3 μL/min for a trap 
• 300 μL/min for a column 

6. Secure the free end of the sample loop into port 5 of the 6-port valve and tighten the 
fitting (refer to Figure D-12). 

7. Perform an aspiration test (refer to “Test the Aspiration Path”). 

D.8 Replace the Syringe Valve 
The remaining element of the aspiration path is the syringe valve. If the sample needle, valve 
components, sample loop, buffer tubing, and syringe have been eliminated, then the syringe 
valve may need to be replaced by an AB SCIEX Field Service Employee. Contact AB SCIEX 
technical support to schedule an appointment. 
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D.9 Plumbing Diagram 
A plumbing diagram for the basic autosampler configuration is shown in Figure D-12. 

 
Figure D-12 Autosampler Plumbing Diagram 
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